# Table of Contents

Preface .......................................................................................................................... 1
  Purpose ......................................................................................................................... 1
  Audience ......................................................................................................................... 1
  Organization .................................................................................................................. 1
  Related Documentation ............................................................................................... 2
  Conventions .................................................................................................................... 2
  Obtaining Documentation .............................................................................................. 3
    Cisco.com ....................................................................................................................... 3
    Product Documentation DVD ......................................................................................... 4
    Ordering Documentation ................................................................................................. 4
  Documentation Feedback ............................................................................................... 4
  Field Alerts and Field Notices ....................................................................................... 4
  Cisco Product Security Overview ..................................................................................... 5
    Reporting Security Problems in Cisco Products ............................................................. 5
  Obtaining Technical Assistance ...................................................................................... 6
    Cisco Technical Support & Documentation Website ....................................................... 6
    Submitting a Service Request ........................................................................................ 7
    Definitions of Service Request Severity ........................................................................ 7
  Obtaining Additional Publications and Information ...................................................... 8

Part 1. Managing IPCC Enterprise Agents and Call Routing ............................................. 11

1. System IPCC to ICM Component and Feature Comparison ........................................ 13
   System IPCC to ICM Component Mapping .................................................................. 13
   System IPCC to ICM Object Mapping ........................................................................... 14
   System IPCC to ICM Installation Differences ............................................................... 14
   System IPCC to ICM Object Mapping ......................................................................... 15

2. IPCC Enterprise Agents .............................................................................................. 17
   About Administering IPCC Enterprise agents .............................................................. 17
     What is an IPCC Enterprise agent? ............................................................................. 17
     ICM Database Records for IPCC Enterprise Voice-Only Agents ............................... 18
     Database Records for IPCC Enterprise Multichannel Agents .................................. 18
     About Agent Desk Settings ......................................................................................... 19
     About Agent Teams and Supervisors .......................................................................... 19
     About Agent Teams and Multichannel Applications ............................................... 20

3. Configuring CTI OS and CAD Desktop Features .......................................................... 23
   About Configuring Agent Features with Agent Desk Settings List Tool ....................... 23
     Agent Wrap-up ............................................................................................................. 23
     Reason Codes ............................................................................................................... 24
     Agent Desk Settings That Affect Reason Codes ......................................................... 24
     Predefined Reason Codes ............................................................................................ 25
    Redirection on No Answer ............................................................................................ 26
     Emergency and Supervisor Assist Calls ...................................................................... 27
   About Configuring Supervisor Features ....................................................................... 27
     Barge-in ......................................................................................................................... 28
     Intercept ....................................................................................................................... 28
   About the Cisco IPCC Enterprise Agent Re-skilling Tool ............................................. 28
   About Network Transfer for IVRs .................................................................................. 29
About IPCC Enterprise Routing.................................................................................................................. 29
  About Routing Operation................................................................................................................................. 29
  About Routing Configuration................................................................................................................................. 31
  About Routing Scripts........................................................................................................................................ 34

4. Routing Tasks for Multichannel Options........................................................................................................ 35
  Configuring ICM/IPCC software for Multichannel Routing.............................................................................. 35
  Configuring Multichannel Software....................................................................................................................... 36

Part 2. Performing Administrative Tasks with Cisco IPCC Enterprise................................................................. 37

5. Administering Agents........................................................................................................................................... 39
  How to Administer Agents.................................................................................................................................. 39
    How to Create IPCC Enterprise Voice-Only Agents......................................................................................... 39
    How to Delete IPCC Enterprise Voice-Only Agents.......................................................................................... 40
    How to Create an Agent Supervisor................................................................................................................... 41
    How to Delete an Agent Supervisor.................................................................................................................... 41
    How to Create Agent Teams.................................................................................................................................. 41
    How to Delete Agent Teams.................................................................................................................................. 42
    How to Create Multichannel Agents...................................................................................................................... 42
    How to Delete Multichannel Agents...................................................................................................................... 42
  How to Configure Not Ready Reason Codes....................................................................................................... 43
  How to Configure Agent Features.......................................................................................................................... 44
    How to Configure IPCC Enterprise for Redirection on No Answer Situations on IP IVR.................................. 44
    How to Configure IPCC Enterprise for Redirection on No Answer Situations on CVP/ISN............................ 45
    How to Configure Automatic Wrap-Up............................................................................................................... 47
    How to Configure Supervisor Assist and Emergency Alert Situations.......................................................... 47
  How to Configure Supervisor Features.................................................................................................................. 48
    How to Configure Supervisor Logged-in State for CAD.................................................................................. 48
  Using the IPCC Enterprise Agent Re-skilling Tool............................................................................................... 49
    Accessing the IPCC Enterprise Agent Re-skilling Tool..................................................................................... 49
  Configuring Network Transfer for IVRs.................................................................................................................. 50
    How to Configure Network Transfer from an IP Phone.................................................................................... 50
    How to Configure Network Transfer from a CTI OS Desktop....................................................................... 51

6. Routing Voice Calls with IPCC Enterprise...................................................................................................... 53
  How to Set Up IPCC Enterprise Voice Routing.................................................................................................. 53
    How to Configure a Device Target with IPCC Enterprise.............................................................................. 53
    Setting up Duplicate Extensions in Multi-Site IPCC Enterprise Installations.................................................. 53
  How to Route to a Target Device with IPCC Enterprise.................................................................................... 54
    On the CallManager.......................................................................................................................................... 54
    Using the ICM Configuration Manager............................................................................................................. 54
    How to Enable Subskill Peripherals and Skill Groups......................................................................................... 54

7. The Dialed Number Plan...................................................................................................................................... 57
  About the Dialed Number Plan.............................................................................................................................. 57
    Understanding the Dialed Number Plan............................................................................................................... 57
    Using the Dialed Number Plan to Ensure ICM Routing of Agent Calls........................................................... 58
    Using the Dialed Number Plan to Set Up Basic Dialing Substitutions.............................................................. 58
  About Dialed Number Plan Values........................................................................................................................ 58
    Wildcard Pattern................................................................................................................................................. 59
    Routing Client................................................................................................................................................... 59
    Post Route......................................................................................................................................................... 59
    Dialed Number.................................................................................................................................................. 59
How to Delete a Dialed Number...........................................................................................................86
Dialed Number Fields...........................................................................................................................86
Index ..........................................................................................................................................................89
List of Figures

Figure 1: Dialed Number Plan Entry Specifying ICM Routing for the Agent Call........................................................59
Preface

Purpose

This manual describes how to administer components of the Cisco IP Contact Center (IPCC) Enterprise Edition solution. It includes information about administering IPCC Enterprise for both voice and mutichannel contact centers.

Audience

This document is intended for Contact Center Supervisors and Administrators.

Organization

The following table describes the information contained in each section of this guide:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part I: Managing IPCC Enterprise Agents and Call Routing (page 11)</td>
<td>Provides information regarding the differences between IPCC Enterprise and System IPCC when deployed with ICM software, along with conceptual information about IPCC Enterprise agents, agent features, and call routing.</td>
</tr>
<tr>
<td>Part II: Performing Administrative Tasks with Cisco IPCC Enterprise (page 37)</td>
<td>Describes how to perform administrative tasks using IPCC Enterprise with ICM software.</td>
</tr>
<tr>
<td>Part III: Performing Administrative Tasks with the Cisco IPCC Enterprise Web Administration Tool (page 65)</td>
<td>Describes how to perform administrative tasks using the IPCC Enterprise Web Administration Tool with a System IPCC deployment.</td>
</tr>
</tbody>
</table>
Related Documentation

For additional information about Cisco Intelligent Contact Management (ICM) software, see the Cisco web page (http://www.cisco.com/univercd/home/home.htm) listing ICM documentation. Refer to the Documentation Guide for Cisco IPCC Enterprise Edition for a list of IPCC documentation.

Conventions

This manual uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong> font</td>
<td>Boldface font is used to indicate commands, such as user entries, keys, buttons, and folder and submenu names. For example:</td>
</tr>
<tr>
<td></td>
<td>• Choose <strong>Edit &gt; Find</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Finish</strong>.</td>
</tr>
<tr>
<td>italic font</td>
<td>Italic font is used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• To introduce a new term. Example: A <strong>skill group</strong> is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td></td>
<td>• For emphasis. Example: <strong>Do not</strong> use the numerical naming convention.</td>
</tr>
<tr>
<td></td>
<td>• A syntax value that the user must replace. Example: <strong>IF</strong> (<strong>condition</strong>, <strong>true-value</strong>, <strong>false-value</strong>)</td>
</tr>
<tr>
<td></td>
<td>• A book title. Example: See the <strong>Cisco CRS Installation Guide</strong>.</td>
</tr>
</tbody>
</table>
### Convention

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>window font</strong></td>
<td>Window font, such as Courier, is used for the following:</td>
</tr>
<tr>
<td></td>
<td>• Text as it appears in code or that the window displays. Example: <code>&lt;html&gt;&lt;title&gt;Cisco Systems, Inc. &lt;/title&gt;&lt;/html&gt;</code></td>
</tr>
<tr>
<td></td>
<td>• File names. Example: <code>tserver.properties</code>.</td>
</tr>
<tr>
<td></td>
<td>• Directory paths. Example: <code>C:\Program Files\Cisco</code>.</td>
</tr>
<tr>
<td><code>&lt; &gt;</code></td>
<td>Angle brackets are used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• For arguments where the context does not allow italic, such as ASCII output.</td>
</tr>
<tr>
<td></td>
<td>• A character string that the user enters but that does not appear on the window such as a password.</td>
</tr>
</tbody>
</table>

---

### Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several ways to obtain technical assistance and other technical resources. These sections explain how to obtain technical information from Cisco Systems.

**Cisco.com**

You can access the most current Cisco documentation at this URL:

[http://www.cisco.com/techsupport](http://www.cisco.com/techsupport)

You can access the Cisco website at this URL:

[http://www.cisco.com](http://www.cisco.com)

You can access international Cisco websites at this URL:

Product Documentation DVD

The Product Documentation DVD is a comprehensive library of technical product documentation on a portable medium. The DVD enables you to access multiple versions of installation, configuration, and command guides for Cisco hardware and software products. With the DVD, you have access to the same HTML documentation that is found on the Cisco website without being connected to the Internet. Certain products also have .PDF versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. Registered Cisco.com users (Cisco direct customers) can order a Product Documentation DVD (product number DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation

Registered Cisco.com users may order Cisco documentation at the Product Documentation Store in the Cisco Marketplace at this URL::

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. to 5:00 p.m. (0800 to 1700) PDT by calling 1 866 463-3487 in the United States and Canada, or elsewhere by calling 011 408 519-5055. You can also order documentation by e-mail at tech-doc-store-mkpl@external.cisco.com or by fax at 1 408 519-5001 in the United States and Canada, or elsewhere at 011 408 519-5001.

Documentation Feedback

You can rate and provide feedback about Cisco technical documents by completing the online feedback form that appears with the technical documents on Cisco.com.

You can submit comments about Cisco documentation by using the response card (if present) behind the front cover of your document or by writing to the following address:

Cisco Systems Attn: Customer Document Ordering 170 West Tasman Drive San Jose, CA 95134-9883

We appreciate your comments.

Field Alerts and Field Notices

Cisco products may be modified or key processes may be determined important. These are announced through use of the Cisco Field Alert and Cisco Field Notice mechanisms. You can register to receive Field Alerts and Field Notices through the Product Alert Tool on Cisco.com.
This tool enables you to create a profile to receive announcements by selecting all products of interest. Log into www.cisco.com (http://www.cisco.com) then access the tool at http://tools.cisco.com/Support/PAT/do/ViewMyProfiles.do?local=en.

Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:


From this site, you will find information about how to:

- Report security vulnerabilities in Cisco products.
- Obtain assistance with security incidents that involve Cisco products.
- Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS) feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:


Reporting Security Problems in Cisco Products

Cisco is committed to delivering secure products. We test our products internally before we release them, and we strive to correct all vulnerabilities quickly. If you think that you might have identified a vulnerability in a Cisco product, contact PSIRT:

- For Emergencies only: security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which a severe and urgent security vulnerability should be reported. All other conditions are considered nonemergencies.

- For Nonemergencies: psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

- 1 877 228-7302
- 1 408 525-6532
**Obtaining Technical Assistance**

Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco Technical Support & Documentation website on Cisco.com features extensive online support resources. In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC) engineers provide telephone support. If you do not have a valid Cisco service contract, contact your reseller.

**Cisco Technical Support & Documentation Website**

The Cisco Technical Support & Documentation website provides online documents and tools for troubleshooting and resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com user ID and password. If you have a valid service contract but do not have a user ID or password, you can register at this URL:


**Note:** Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting a web or phone request for service. You can access the CPI tool from the Cisco Technical Support & Documentation website by clicking the Tools & Resources Tools. Choose Cisco Product Identification Tool from the Alphabetical Index drop-down list, or click the Cisco Product Identification Tool RMAs. The CPI tool offers three search options: by product ID or model name; by tree view; or for certain products, by copying and pastingshow command output. Search results show an illustration of your product with the serial number label location highlighted. Locate the serial number label on your product and record the information before placing a service call.
Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 and S4 service requests are those in which your network is minimally impaired or for which you require product information.) After you describe your situation, the TAC Service Request Tool provides recommended solutions. If your issue is not resolved using the recommended resources, your service request is assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. (S1 or S2 service requests are those in which your production network is down or severely degraded.) Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business operations running smoothly.

To open a service request by telephone, use one of the following numbers:

- Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
- EMEA: +32 2 704 55 55
- USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has established severity definitions.

Severity 1 (S1) - Your network is down, or there is a critical impact to your business operations. You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2) - Operation of an existing network is severely degraded, or significant aspects of your business operation are negatively affected by inadequate performance of Cisco products. You and Cisco will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3) - Operational performance of your network is impaired, but most business operations remain functional. You and Cisco will commit resources during normal business hours to restore service to satisfactory levels.

Severity 4 (S4) - You require information or assistance with Cisco product capabilities, installation, or configuration. There is little or no effect on your business operations.
Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online and printed sources.

- **Cisco Product Quick Reference Guide** is a handy, compact reference tool that includes brief product overviews, key features, sample part numbers, and abbreviated technical specifications for many Cisco products that are sold through channel partners. It is updated twice a year and includes the latest Cisco offerings. To order and find out more about the Cisco Product Quick Reference Guide, go to this URL:


- Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit Cisco Marketplace, the company store, at this URL:


- **Cisco Press** publishes a wide range of general networking, training and certification titles. Both new and experienced users will benefit from these publications. For current Cisco Press titles and other information, go to Cisco Press at this URL:

  [http://www.ciscopress.com](http://www.ciscopress.com)

- **Packet** magazine is the Cisco Systems technical user magazine for maximizing Internet and networking investments. Each quarter, Packet delivers coverage of the latest industry trends, technology breakthroughs, and Cisco products and solutions, as well as network deployment and troubleshooting tips, configuration examples, customer case studies, certification and training information, and links to scores of in-depth online resources. You can access Packet magazine at this URL:


- **iQ Magazine** is the quarterly publication from Cisco Systems designed to help growing companies learn how they can use technology to increase revenue, streamline their business, and expand services. The publication identifies the challenges facing these companies and the technologies to help solve them, using real-world case studies and business strategies to help readers make sound technology investment decisions. You can access iQ Magazine at this URL:


- **Internet Protocol Journal** is a quarterly journal published by Cisco Systems for engineering professionals involved in designing, developing, and operating public and private internets and intranets. You can access the Internet Protocol Journal at this URL:

  [http://www.cisco.com/ipj](http://www.cisco.com/ipj)

- Networking products offered by Cisco Systems, as well as customer support services, can be obtained at this URL:
Networking Professionals Connection is an interactive website for networking professionals to share questions, suggestions, and information about networking products and technologies with Cisco experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

World-class networking training is available from Cisco. You can view current offerings at this URL:

Part 1: Managing IPCC Enterprise Agents and Call Routing

The following sections provide information regarding the differences between IPCC Enterprise and System IPCC when deployed with ICM software, along with conceptual information about IPCC Enterprise agents, agent features, and call routing.
IPCC Enterprise can be deployed two different ways: with the standard ICM installer or with the new, streamlined System IPCC installer. This chapter summarizes the differences between these two deployments. Be aware of these differences when reviewing the remaining chapters in this section.

This section contains the following topics:

- System IPCC to ICM Component Mapping, page 13
- System IPCC to ICM Object Mapping, page 14
- System IPCC to ICM Installation Differences, page 14
- Using System IPCC, page 15

System IPCC to ICM Component Mapping

The table below maps System IPCC machine types to their equivalent ICM components.

<table>
<thead>
<tr>
<th>System IPCC Machine Type</th>
<th>Corresponding ICM Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Controller</td>
<td>CallRouter, Logger</td>
</tr>
<tr>
<td>Agent/IVR Controller</td>
<td>System PG, CTI Server, CTI OS Server</td>
</tr>
<tr>
<td>Administration &amp; WebView Reporting</td>
<td>Distributor Admin Workstation, Historical Data Server (HDS), WebView</td>
</tr>
<tr>
<td>Multichannel Controller</td>
<td>Media Routing Peripheral Gateway (MR PG)</td>
</tr>
<tr>
<td>Outbound Controller</td>
<td>Outbound Dialer, MR PG</td>
</tr>
</tbody>
</table>
System IPCC to ICM Object Mapping

Following is a list of ICM objects either not used or renamed in System IPCC:

- While the following ICM objects are supported by system IPCC, they are configured automatically and therefore are not exposed through the configuration tools: labels, persons, device targets, and trunk groups.

- Configuration of translation routes is automatic—no manual configuration is required.

- System IPCC does not support post routing within a System IPCC deployment. Post routing is supported between a child System IPCC and its parent in an IPCC Gateway deployment. (See your IPCC Gateway documentation for more information.)

- System IPCC does not support services, sub-skill groups, or Dialed Number Plan configuration.

- System IPCC’s call variables are equivalent to ICM’s expanded call context variables.

- System IPCC’s network IVR is equivalent to ICM’s network VRU.

System IPCC to ICM Installation Differences

Following is a list of differences between the way certain shared ICM/System components are installed in System IPCC versus in ICM:

- System IPCC supports a single customer instance per Active Directory Facility OU. This instance is automatically named "ipcc."

- All ICM databases and the Outbound Option database are installed, sized, and configured automatically in System IPCC installs. No manual configuration of these databases is required.

- The IPCC System PG is installed and configured transparently in System IPCC. This is the only Agent PG type supported by System IPCC. No manual configuration of PG client type, PIMs, etc. is required.

- WebView and the WebView 3rd Party Utilities are installed automatically in System IPCC. No manual install of these product components is required. Agent Reporting is automatically enabled in System IPCC; it does not need to be manually enabled. All prospective WebView users must first have an account on the System IPCC’s Active Directory domain. Outbound Option reporting templates are installed automatically and appear in WebView whether Outbound is deployed or not.
Using System IPCC

System IPCC provides a new, streamlined web administration tool that provides an efficient installation process. Details about this tool, the IPCC Enterprise Web Administration Tool, are found in the About the IPCC Enterprise Web Administration Tool (page 67) section.

Note: System IPCC only supports one IPCC System PG (duplexed) with up to five IP IVRS, an optional Outbound Controller and an optional Cisco Email Manager and Cisco Collaboration Server Controller.
This chapter explains the concepts you must be familiar with when setting up agents for your IPCC Enterprise contact center.

About Administering IPCC Enterprise agents

What is an IPCC Enterprise agent?

An agent is an individual who handles customer contact within your contact center. In an IPCC Enterprise configuration, you can create these types of agents:

<table>
<thead>
<tr>
<th>Agent type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice-only agents</td>
<td>Agents who can receive telephone calls are referred to as Voice agents. Note that a Voice agent can also be configured to receive non-voice requests, such as Single-session Chat, Multi-Session Chat, Blended Collaboration, and E-Mail.</td>
</tr>
<tr>
<td>Multichannel agents</td>
<td>Agents who can handle voice calls and requests from other media. (You can create this type of agent only if you have Cisco’s multichannel software installed as part of your IPCC Enterprise configuration.) In addition to setting up multichannel agents to handle voice and non-voice requests, you can also set them up to only receive non-voice requests; that is, a multichannel agent can be configured to handle only Single-session chat, Multi-session chat, and E-Mail requests.</td>
</tr>
</tbody>
</table>

Note: In most cases, the CallManager peripheral on the Generic IPCC PG (set up with your initial IPCC Enterprise installation) tracks and records the state and activity of all voice and non-voice agents. You can configure a Non-Voice PG rather than a CallManager PG to monitor state and activity of agents who are non-voice agents. However, this is optional, and not necessary if you already have a CallManager peripheral on the Generic IPCC PG. When using System IPCC, agent tracking is performed using the Agent/IVR Controller.
ICM Database Records for IPCC Enterprise Voice-Only Agents

In the ICM database, each agent must be associated with two database records:

<table>
<thead>
<tr>
<th>ICM database record</th>
<th>Description</th>
</tr>
</thead>
</table>
| Person record       | Identifies the individual. Person records must exist for all IPCC Enterprise agents. Every agent in your configuration must have a single person record. This record can then be associated with one or multiple agent records, as described below.  
**Note:** System IPCC automatically sets the Person record. In System IPCC, there is a one-to-one correspondence between the agent and the person. |
| Agent record        | Identifies the agent working on a particular peripheral. There must be a one-to-one correspondence between each agent record and it’s associated peripheral. However, in IPCC Enterprise, if an agent is going to be working on several peripherals, you can create several agent records and associate these with the same person record. In this way, a single agent can work on several different peripherals. In System IPCC, this only works if done from the parent system. |

When you create an Agent record, you have the option of associating it with an existing Person record (click the **Select Person** button). If you do not associate the Agent record with an existing Person record, a new Person record is automatically created when you create the agent.

Database Records for IPCC Enterprise Multichannel Agents

IPCC Enterprise agents who will use multichannel software are associated with three different database records:

- The person record in the ICM/IPCC database
- The agent record in the ICM/IPCC database
- The agent record in the database for the multichannel application (Cisco Collaboration Server or Cisco E-Mail Manager)

You can create multichannel agents using either the ICM/IPCC Administration User Interface or the Administration interface for the multichannel software. The following table explains why creating multichannel agents using the multichannel software is the preferred method for agent creation.
If you create agents using the ICM/IPCC Administration User Interface:

You must create an agent record in ICM/IPCC software. (Note that a Person record is automatically created).

To handle multichannel contact, agents created in this way must be enabled in the associated multichannel software.

For example, imagine that you create an agent using the ICM/IPCC Administration User Interface and you want that agent to be able to handle Web-initiated Single-session chat, Multi-session chat, and/or Blended Collaboration requests. To do so, you must use the Collaboration Administration desktop to enable the agent on the Collaboration Server.

If you create agents using the multichannel software:

Agent and person records are automatically created in both the multichannel software’s database and the ICM database.

You need not create a person or agent record in the ICM/IPCC Administration User Interface.

For agents who will work only in the multichannel non-Voice MRDs, create the agents in the multichannel applications.

For voice agents who also handle multichannel tasks, set up these agents in the multichannel applications first, then add the agents to a voice skill group in ICM/IPCC software.

Note: Agents already created in ICM/IPCC software that belong to voice skill groups can be enabled in Cisco E-Mail Manager or Cisco Collaboration Server through their respective administration interfaces, and can be added to email and collaboration skill groups.

Configuring an agent for multichannel requires assigning that agent skill groups for each media type that he or she will handle. For example, the agent might handle both e-mail and phones, Single-session chat and phones, or Blended Collaboration and E-Mail.

About Agent Desk Settings

Each agent record must be associated with an Agent Desk Setting. The Agent Desk Settings configuration is used to associate a set of permissions or characteristics with specific agents. These settings are comparable to Class of Service settings on a PBX or ACD. Desk settings are associated with an agent when the agent is configured in the ICM database. The desk settings are global in scope and they can be applied to any configured agent on any peripheral within an ICM/IPCC configuration.

If desktop settings are not associated with a configured agent, the agent is assigned the peripheral default settings. The peripheral default settings will depend on the default setting for the Generic IPCC PG the agent is logged in to.

Note: See About Configuring Agent Features with Agent Desk Settings List Tool (page 23) for detailed information.

About Agent Teams and Supervisors

You can organize IPCC Enterprise voice agents into teams. A team is a collection of agents grouped for reporting purposes. Note that a single agent can belong to only one team.
ICM/IPCC software allows you to group individual agents into agent teams that can be managed by supervisors. Agent teams are assigned to a specific peripheral, so all agents of a given team must also be assigned to the same CallManager peripheral.

ICM/IPCC software lets you assign both Primary and Secondary supervisors to an individual team. It is recommended that you set up your teams with both a Primary and a Secondary supervisor. This setup will help to accommodate Supervisor and Emergency assist scenarios.

Supervisors listed on the Agents team list will be able to view real-time statistics (via WebView). Supervisors can, for example, barge-in, intercept, silently monitor, and log out agents in the associated team using the CTI Toolkit IPCC Supervisor Desktop (Win32) application.

**Note:** If you use Cisco Agent Desktop (CAD), you must configure the supervisor in ICM/IPCC software first, then configure the supervisory features within CAD.

For reporting purposes, you can report on agent teams and agents grouped into teams. Also, supervisors can run reports on their teams. (Refer to the Reporting Guide for Cisco IPCC Enterprise & Hosted Editions for detailed information about reporting.)

Each team you set up must have an agent supervisor associated with it. You can then configure supervisory agent features, to allow the supervisor to better monitor agent activity and assist agents on their team. When you create an agent supervisor, you must enter the following information for the supervisor:

- Windows Domain name to which the agent team belongs
- Windows User ID for the supervisor
- Windows password for the supervisor

When configuring agent teams, be aware of the following rules:

- An agent can be a member of only one agent team.
- An agent team can have only one Primary Supervisor
- A supervisor can be a supervisor of any number of agent teams.
- A supervisor for an agent team can also be a member of that agent team.
- All agents belonging to an agent team and all supervisors for that agent team must be on the same peripheral.
- A supervisor cannot be using the Windows administrator account when logging in as supervisor.

**About Agent Teams and Multichannel Applications**

You can group voice agents into teams using the ICM/IPCC Administration User Interface. Note, however, that there is no team feature in Collaboration Server or in the ICM-integrated
E-Mail Manager (teams are available for stand-alone E-Mail). Therefore, Collaboration-only agents and E-Mail-only agents cannot be grouped into teams.

**See Also**

For information about agent features, see *Configuring CTI OS and CAD Desktop Features* (page 23).

About Administering IPCC Enterprise agents
About Configuring CTI OS and CAD Desktop Features

This section contains the following topics:

• About Configuring Agent Features with Agent Desk Settings List Tool, page 23
• About Configuring Supervisor Features, page 27
• About the Cisco IPCC Enterprise Agent Re-skilling Tool, page 28
• About Network Transfer for IVRs, page 29
• About IPCC Enterprise Routing, page 29

About Configuring Agent Features with Agent Desk Settings List Tool

Each voice agent record must be associated with an Agent Desk Setting (not necessary for non-voice agents). The Agent Desk Settings List tool configuration is used to associate a set of permissions or characteristics with specific agents. You can use the Agent Desk Settings List tool to configure these agent features.

• Agent Wrap-up

• Reason Codes

• Redirection on No Answer

• Emergency and Supervisor Assist Calls

Agent Wrap-up

Agents can enter Wrap-up mode after completing a call. Wrap-up mode enables the agent to finish with any tasks that require after-call work before entering a Ready state. When in Wrap-up mode, the agent is not routed any additional tasks.

Agents can manually enter Wrap-up state by activating the wrap-up button on their soft phone. You can also configure agent desk settings so that agents automatically enter Wrap-up mode after finishing each call, as described below.
When you create Agent Desk Settings using the ICM/IPCC Administration User Interface, you can specify whether agents enter Wrap-up mode automatically after finishing incoming calls. The Work Mode Settings allow you to specify whether the agent must enter Wrap-up mode after incoming calls. You can also use these settings to require agents to enter reason codes while in Wrap-up mode (incoming calls only).

Reason Codes

Agents select reason codes when they:

- Log out of the agent desktop system
- Enter Wrap-up mode after a call
- Change to a Not Ready state

Reason codes allow you to track the agent’s state and logout status as it changes. You configure reason codes using the agent desktop application (CTI OS and/or the CAD administrator’s desktop). If you use the CTI OS desktop, you can also configure ICM/IPCC software to control when reason codes are required.

Agent Desk Settings That Affect Reason Codes

<table>
<thead>
<tr>
<th>Agent Desk Setting Option</th>
<th>Affects this type of reason code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work mode on Incoming</td>
<td>Wrap-up</td>
</tr>
<tr>
<td>Idle reason required</td>
<td>Not Ready</td>
</tr>
<tr>
<td>Logout reason required</td>
<td>Logout</td>
</tr>
</tbody>
</table>

Wrap-Up Reason Codes and Work Mode

If you use the CTI Toolkit Agent Desktop (Win32), you can use the Work Mode on Incoming option on the Agent Desk Settings List window to specify when and if agents will be required to enter reason codes when entering wrap up for incoming calls. The following table describes Work Mode on Incoming options and explains how reason codes are related to each:

<table>
<thead>
<tr>
<th>Work Mode</th>
<th>Description</th>
<th>Reason Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>Ensures that the agent automatically enters Wrap-up state after completing the call.</td>
<td>The agent can choose to enter a reason code.</td>
</tr>
<tr>
<td>Optional</td>
<td>Allows agents to choose whether to activate the wrap-up button or the Not Ready button to end the call.</td>
<td>If the agent uses the wrap-up button, the agent can choose to enter a reason code.</td>
</tr>
<tr>
<td>Not Allowed</td>
<td>Restricts the agent from entering Wrap-up mode. The Agent can go into Not Ready mode.</td>
<td>The agent can decide whether to enter a Not Ready reason code.</td>
</tr>
<tr>
<td>Required with wrap-up data</td>
<td>Ensures that the agent automatically enters Wrap-up state after completing the call.</td>
<td>The agent must enter a reason code.</td>
</tr>
</tbody>
</table>
The following table describes the CAD configuration for Work Mode on Incoming options:

<table>
<thead>
<tr>
<th>Work Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>Not used with CAD.</td>
</tr>
<tr>
<td>Optional</td>
<td>Recommended setting when using CAD.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Configure Wrap-up options in Cisco Desktop Administrator.</td>
</tr>
<tr>
<td>Not Allowed</td>
<td>Not used with CAD.</td>
</tr>
<tr>
<td>Required with wrap-up data</td>
<td>Not used with CAD.</td>
</tr>
</tbody>
</table>

The following table describes the CAD configuration for Work Mode on Outgoing options:

<table>
<thead>
<tr>
<th>Work Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>When the agent drops an outbound call, the agent goes into a Work Not Ready state for the time specified in the Wrap-up time in the agent desk settings and pops the Wrap-up options, if they are enabled in the CAD Desktop Administrator application.</td>
</tr>
<tr>
<td>Optional</td>
<td>Recommended setting if not using Wrap-up options for outbound calls.</td>
</tr>
<tr>
<td>Not Allowed</td>
<td>Not used with CAD.</td>
</tr>
<tr>
<td>Required with wrap-up data</td>
<td>Not used with CAD.</td>
</tr>
</tbody>
</table>

Predefined Reason Codes

IPCC Enterprise uses several predefined reason codes to indicate certain system events, described in the following table:

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>50001</td>
<td>The CTI OS client disconnected, logging the agent out.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This reason code is converted to a 50002, so 50001 does not display in the agent log out records.</td>
</tr>
<tr>
<td>50003</td>
<td>Agent was logged out because the CallManager reported the device out of service.</td>
</tr>
<tr>
<td>50004</td>
<td>Agent was logged out due to agent inactivity as configured in agent desk settings.</td>
</tr>
<tr>
<td>50020</td>
<td>Agent was logged out when his/her skill group dynamically changed on the AW.</td>
</tr>
</tbody>
</table>
Reason Code | Description
-------------|-------------------
32767        | Agent state changed since the agent did not answer the call.
50002        | A CTI OS component disconnected, causing the agent to be logged out or set to the Not Ready state. This could be due to closing the agent desktop application, heart beat time out, or a CTI OS Server failure.
50010        | Agent was set to Not Ready state because they were routed two consecutive calls that did not arrive.
-1           | Agent reinitialized (used if peripheral restarts).
-2           | PG reset the agent, normally due to a PG failure.
-3           | An administrator modified the agent’s extension while the agent was logged in.

These reason codes appear in these reports:

- Agent log out reports if the event caused the agent to log out
- Agent real time reports if the agent was set to a Not Ready state
- Agent Not Ready reports

**Note: Important!** For reporting on all PGs other than VRU PGs, make sure you check the **Agent event detail** check box on the Agent Distribution tab in the ICM/IPCC Administration User Interface’s PG Explorer tool. This check box must be enabled to report on Not Ready reason codes.

If you are using CAD, the Desktop Administrator uses the following predefined reason codes:

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20001</td>
<td>Places the agent in the Not Ready state first before forcefully logging them off.</td>
</tr>
<tr>
<td>20002</td>
<td>Forces the logout request.</td>
</tr>
<tr>
<td>20003</td>
<td>If not already in the Logout state, request is made to place agent in the Not Ready state. Then logout request is made to log agent out.</td>
</tr>
<tr>
<td>Supervisor Not Ready</td>
<td>This code is reserved.</td>
</tr>
<tr>
<td>Supervisor Logout</td>
<td>This code is reserved.</td>
</tr>
</tbody>
</table>

**Redirection on No Answer**

You can configure your IPCC Enterprise system to handle and accurately report on situations when the agent does not answer his or her phone. These situations are referred to as Redirection on No Answer.
Although you can specify some values that control Redirection on No Answer situations, configuring Redirection on No Answer involves additional steps:

- ICM/IPCC configuration
- ICM/IPCC scripting
- CallManager configuration

Redirection on No Answer conditions are handled by two routing scripts: the initial routing script and a script specifically set up for these conditions. The initial routing script handles the incoming call; when the call is redirected on no answer from the agent’s IP phone, the script will branch to another script set up specifically for Ring No Answer conditions.

**Note:** The Target Requery script feature, implemented using the Label, Queue, Route Select, and Select nodes, is not supported for IPCC Enterprise systems; however, it is supported for Cisco Customer Voice Portal (CVP/ISN).

### Emergency and Supervisor Assist Calls

Agents can activate supervisor assist or emergency assist buttons on their desktop when they need special assistance from the primary or secondary supervisor assigned to their team.

Agents can use the Supervisor and Emergency assist features, regardless of whether or not they are on a call.

There are two types of supervisor and emergency assist calls:

- Existing call - Consultative Conference
- No call

**Note:** Blind Conference is not supported for Emergency and Supervisor Assist.

### About Configuring Supervisor Features

**Note:** If you use Cisco Agent Desktop (CAD), you must configure the supervisor in ICM/IPCC software first, then configure the supervisory features using Cisco Desktop Administrator.

The IPCC Enterprise Supervisor Desktop includes functions that allow supervisors to monitor and manage their agent team members. A supervisor desktop application has all of the capabilities of an agent desktop application plus supervisor services to monitor and manage agent team members. The desktop application supports the Barge-In and Intercept call monitoring features.

**Note:** Refer to the Reporting Guide for Cisco IPCC Enterprise & Hosted Editions for information on setting up IPCC Enterprise supervisory features. These instructions help ensure successful use of these features and accurate reporting. See How to Create an Agent Supervisor (page 39) for information about configuring supervisor features.
Barge-in

When using the CTI OS Desktop to barge in on an agent’s call, a supervisor needs to select an agent from the Team State Information grid and select a call from the Monitored Calls section. The supervisor can select a call in this window and then click the **Barge-In** button. The supervisor then becomes party to the call. The supervisor must be in the Not Ready state in order to use the barge-in function.

When using Cisco Supervisor Desktop (CSD), an agent supervisor can use the barge-in function when he or she is in the Ready or Not Ready state.

CSD does not allow barge-in when the agent is:

- On hold
- On two calls
- On a conference call
- The CSD self is on another call
- An IP Phone agent

Intercept

When using the CTI OS Desktop, the **Intercept** button can only be used after barge-in. The supervisor can use the **Intercept** button to remove the agent from the call, leaving only the supervisor and the customer on the call.

When using CSD, an agent supervisor can intercept an agent’s call without using Barge-In.

CSD does not allow intercept when the agent is:

- On hold
- On two calls
- The CSD self is on another call
- An IP Phone agent

About the Cisco IPCC Enterprise Agent Re-skilling Tool

The IPCC Enterprise Agent Re-skilling Tool is an optional, browser-based application designed for use by IPCC call-center supervisors. It lets you change the skill group designations of agents on your team, and quickly view skill group members and details on individual agents. Changes
you make to an agent's skill group membership take place immediately without need for the agent to exit and re-enter the system.

**Note:**

- For agents currently in a call, a change to their skill group membership will not take place until the call has terminated.
- If your company has chosen to install this tool, you can perform the functions listed above. The Agent Re-skilling Tool is an optional tool, so this tool might not be available on your system.

### About Network Transfer for IVRs

When a call is transferred from an IVR (for example, IP IVR) to an agent and that agent wants to transfer the call to another agent, the transfer can be made either from the agent’s IP phone or the agent desktop.

Transfers made from the:

- IP phone are made using CTI route points that point to an ICM/IPCC script.
- Agent desktop are made using the Dialed Number Plan.

For network transfer from either the IP phone or the CTI Toolkit Agent Desktop (Win32), you must queue the call to the skill group in the first ICM/IPCC script; for example, “NetXfer1,” to create the call context. In this script, the “networkTransferEnabled” flag must be set to “1.”

### About IPCC Enterprise Routing

To understand how IPCC Enterprise routes voice call, you must understand the concepts of routing operation and routing configuration.

#### About Routing Operation

To understand how IPCC Enterprise routing occurs, you must understand these concepts:

- **The Routing Client:** The IPCC Enterprise component that submits a route request to the Central Controller.

In IPCC Enterprise configurations, the routing client can be:

- The CallManager PG or System IPCC Agent/IVR Controller
- An interexchange carrier (IXC)
- A VRU PG
A Media Routing Peripheral Gateway (for Cisco Collaboration Server and Cisco E-Mail Manager contacts)

Essentially, when a routing client makes a request for a route from the ICM/IPCC platform, it receives the response and delivers the call to the specified destination. If an IPCC Enterprise agent is available, ICM/IPCC software routes the call to the device target (phone) on the CallManager (device targets are dynamically associated with the agent when the agent logs in to the system). If an agent is not available, ICM/IPCC software can be configured to queue the call to IP IVR or CVP/ISN.

**Route and Queuing Requests:** Messages sent from the routing client to the Central Controller. Route requests typically pass on call detail information about the incoming call. ICM/IPCC software uses information in the route request to determine which routing script will be run for the call.

Call detail information sent with the route request can include:

- Dialed Number
- Calling line ID
- Caller Entered Digits

Queueing requests are messages sent from the VRU using the Cisco Service Control Interface. The VRU makes a queue request to provide announcements or music when no IPCC Enterprise agents are available to take the call.

**About Routing to the VRU with IPCC Enterprise:** With IPCC Enterprise you can ensure that voice calls are routed to the VRU when an agent is not immediately available. The call is queued to the VRU and will be sent to the next available agent via the routing script.

The configurations for routing to a VRU in an IPCC Enterprise environment include:

- Translation Route to the VRU via a route on the PG. The CallManager uses the DNIS in the translation route to direct the call to the VRU.

- A network route request is issued by the carrier via the NIC. The DNIS and/or Correlation ID is retrieved from the carrier.

- The call is sent directly to the VRU, so that caller entered digits (CED) can be collected.

You do not need a translation route to a CallManager PG since it is targeting agents and implicitly matches call data.

**Routing a Call to the VRU:** Translation routing is the preferred method of routing a call to the VRU. The DNIS used in the translation route is not the original number dialed by the customer, but rather, the Dialed Number used to route the call to the VRU.

The scenario is as follows:
About IPCC Enterprise Routing

In order to set up routing in your IPCC Enterprise system, you must set up the following entities:

- **Dialed Numbers**: The dialed number is the number that the caller dials to contact an agent. It is sent as part of the call detail information in the route request message sent from the routing client.

  In ICM software, you set up a Dialed Number List, which identifies all of the phone numbers in your contact center that customers can dial to initiate contact.

  **Note**: System IPCC does not support Dialed Number Lists. Instead, it only uses dialed numbers.

  The Dialed Number plays an integral role in routing calls. Dialed Numbers are required pieces of ICM Call types, which are used to identify the appropriate routing script for each call.

- **Call Types**: A call type is a category of incoming ICM routable tasks. Each call type has a schedule that determines which routing script or scripts are active for that call type at any time. There are two classes of call types: voice (phone calls) and non voice (for example, e-mail and text chat). Voice call types are categorized by the dialed number (DN), the
caller-entered digits (CED) and the calling line ID (CLID). Non voice call types are categorized
by the Script Type Selector, Application String 1, and Application String 2. In either case,
the last two categories of the call type can be optional. For voice call types, the caller-entered
digits and the calling line ID can be optional, depending on the call. For non voice call types,
Application String 1 and Application String 2 can be optional, depending on the application.

Because the call type determines which routing script is run for a call, the call type defines
call treatment in an IPCC Enterprise system. Therefore, the call type is the highest level
reporting entity. Reporting on call type activity provides insight into end-to-end customer
interactions with the system and with agents by providing data such as service level adherence,
transfers, average speed of answer, calls handled, and calls abandoned.

In routing scripts, such as scripts for Self-Service VRU applications, you may change the
call type at specific points in the script to indicate that a transaction has been completed. For
example, if the customer is calling a bank and successfully checks his or her account balance
using a Self-Service script, you may want to change the call type to indicate that the account
balance transaction has completed and a new transaction has begun.

You can also change the call type in a script to invoke a new routing script associated with
that call type. For example, if a call is not answered at an agent's desktop, you can change
the call type in the script to redirect the call to a different script designed for Redirection on
No Answer. The Redirection on No Answer script assigns a different agent to handle the
call.

- **Routes:** ICM/IPCC software uses routes to define the mapping of a target to a specific label
  for a routing script. Targets include services (service targets), skill groups (skill targets),
  agents (device targets), and translation routes.

Routes must be defined for VRU Translation Routing and to route calls to agents.

- **Device Targets:** A device target is a telephony device that can be uniquely addressed (or
  identified) by a telephone number. A device target is not associated with any one peripheral.
  Each device target must have one or more labels associated with it, although only one label
  may exist per routing client.

You do not need to use device targets when configuring IPCC Enterprise using the IPCC
Enterprise Web Administration Tool. If you are not using the IPCC Enterprise Web
Administration Tool and you are configuring a System IPCC PG, you must use device targets.

**Note:** Device targets and agents are separate entities. A device target is a separately
addressable device and is not exclusively owned by any particular agent. Device targets are
dynamically associated with CallManager PG agents for the duration of a log in session.

Each CallManager PG telephony device that is used by an agent must be configured in the
ICM database as a device target.

- **Labels:** A label is the value that ICM/IPCC software returns to a routing client instructing
  it where to send the call. The routing client can map the label to an announcement, a trunk
  group and DNIS, or a device target. Special labels might instruct the routing client to take
  another action, such as playing a busy signal or an unanswered ring to the caller.
If the label is for a device target, the routing client is responsible for delivering the call to the device target on the CallManager through the voice gateway.

If the label is for a VRU queue point, the routing client delivers the call to the Route Point on the VRU. The VRU must recognize that the call has arrived and then request queue instructions from ICM/IPCC software. ICM/IPCC software returns either a destination for the call or instructions on what script the VRU will run, based on a particular Call Type.

**Note:** Labels are not used with System IPCC.

**• Services:** You set up Services in ICM/IPCC software to represent the type of processing that a caller requires, and to configure VRU Services to route calls to the VRU. For example, separate services might be defined for Sales, Support, or Accounts Payable. A Service is often associated with a peripheral and can be referred to as a Peripheral Service.

For Services that will be used to route a call to an agent, must be associated with skill groups. You associate different Skill Groups with Services by making them members of the Service. Using Services allows you to group agents working in like skill groups.

**Note:** Services are not used with System IPCC.

**• Skill Groups:** Agents must be associated with skill groups in order to receive ICM-routed calls. You create skill groups using the ICM/IPCC Administration User Interface.

ICM/IPCC software allows you to configure two types of skill groups:

- **Base skill group:** The main skill group created using the ICM/IPCC Administration User Interface. Using base skill groups ensures accurate agent reporting and simplifies configuration and scripting for your contact center.

- **Subskill group:** A subdivision of the base skill group. Subskill groups are optional; Cisco recommends not using subskill groups for IPCC Enterprise configurations.

  **Note:** Subskill groups are not supported in System IPCC.

For IPCC Enterprise systems, we recommend that you configure base skill groups only. To avoid confusion in reporting and scripting, do not configure sub-skill groups.

**Note:** Subskill groups are not supported for non-voice skill groups. That is, you cannot create subskill groups for these media classes: Single-session chat, Multi-session chat, Blended Collaboration, and E-Mail.

**• About Subskill Groups:** Each time you create a skill group, a base skill group is created by default. If you choose to use subskill groups, you must enable the sub group mask. You can enable this mask either at the peripheral level, or at the individual skill group level. Enabling the subgroup mask at the peripheral level, two subskill groups are automatically created each time you create a skill group.

These subskill groups are named as follows:

- `<base skill group name>.pri`
The pri and sec suffixes here indicate primary and secondary. The system generates these suffixes because subskill groups are often used so that the skill can be assigned to some agents as a primary skill, and to others as a secondary skill. Note, however, that primary and secondary skill groups do not, by themselves, affect the priority given to them in an ICM routing script.

If you want to use subskill groups as primary and secondary skill groups, understand that primary and secondary skills alone do not guarantee routing priority. You must build that priority into your routing scripts. You can do so by including separate Queue-to-Skill Group nodes in your routing script, and placing the node that points to the primary skill group before the node that points to the secondary skill group.

Note: If you have subskill groups configured, be aware that agent reports will not report on base skill groups.

• Migrating from Subskill Groups to Base Skill Groups:

If you are upgrading from a previous ICM release and want to migrate from subskill groups to base skill groups, follow these steps:

– Disable the subskill group mask for the peripheral using the PG Explorer tool. All skill groups created after this is done will be base-only skill groups; subskill groups will not be created by default.

– Define new base skill groups that correspond to your subskill groups. Assign agents to the new base skill groups and remove them from your subskill groups.

– Update all of your routing scripts, so that they no longer refer to the subskill groups, and refer only to the base skill groups.

Note: Be sure to be consistent in your use of skill groups in your routing scripts. When using base skill groups, be sure to refer to only base skill groups in your routing scripts. If you choose to use subskill groups (not recommended), be sure to refer to only subskill groups in your routing scripts.

About Routing Scripts

A routing script, created using the Script Editor, identifies the desired agent based upon skills and customer database profile, determines the call target, and returns a route response to the routing client.
Chapter 4

Routing Tasks for Multichannel Options

If you have installed multichannel features with Cisco IPCC Enterprise, you must understand how ICM/IPCC software routes contacts and requests made from the Cisco Collaboration Server server and the Cisco E-Mail Manager server.

This section contains the following topics:

- Configuring ICM/IPCC software for Multichannel Routing, page 35
- Configuring Multichannel Software, page 36

Configuring ICM/IPCC software for Multichannel Routing

To route contact requests submitted from the World Wide Web or E-Mail, you must have configured:

- Media Routing Peripheral Gateway
- Media Routing Domains and Media Classes
- Multichannel agents
- Application instances
- Administration connections
- Multichannel skill groups
- Multichannel routing scripts

See Also

For information on configuring IPCC Enterprise for multichannel routing, refer to the IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition.
Configuring Multichannel Software

Once your ICM/IPCC configuration is complete, you must configure your ICM multichannel software.

For Web Collaboration Option, you must configure:

• Cisco Media Blender

• Cisco Collaboration Server

For E-Mail requests, you must configure Cisco E-Mail Manager.

See Also


For information on configuring the E-Mail Manager option, refer to the Cisco E-Mail Manager Installation and Configuration Guide for Cisco ICM/IPCC Enterprise & Hosted Editions.
Part 2: Performing Administrative Tasks with Cisco IPCC Enterprise

The following sections describe the configuration required for setting up IPCC Enterprise agents and agent features. These sections also provide information on setting up voice and multichannel routing with IPCC Enterprise.

**Note:** The information in this part does not pertain to System IPCC deployments. See Performing Administrative Tasks with the Cisco IPCC Enterprise Web Administration Tool (page 65) if you are deploying System IPCC.
Chapter 5

Administering Agents

This chapter explains the tasks you must be familiar with when setting up agents for your IPCC Enterprise contact center.

This section contains the following topics:

- How to Administer Agents, page 39
- How to Configure Not Ready Reason Codes, page 43
- How to Configure Agent Features, page 44
- How to Configure Supervisor Features, page 48
- Using the IPCC Enterprise Agent Re-skilling Tool, page 49
- Configuring Network Transfer for IVRs, page 50

How to Administer Agents

How to Create IPCC Enterprise Voice-Only Agents

**Note:** You must ensure that you have already set up Agent Desk Settings before configuring agents.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Use the Agent Explorer tool in the ICM Configuration Manager to create an agent record. If you want to associate this agent with an existing Person record, click the <strong>Select Person</strong> button.</td>
<td>Creates an agent record associated with the person record. <strong>Note:</strong> Important! Do not change an agent’s ID while the agent is logged into the CTI Toolkit Agent Desktop (Win32). Enter the agent information and click <strong>Save</strong> to save the record. See the online help for more information. <strong>Note:</strong> Agent IDs can be up to nine digits long. The first digit in the ID must be 1 through 9. It cannot be 0. Also, this number cannot be the same as the extensions on the CCM cluster for this agent.</td>
</tr>
</tbody>
</table>

Example:

ICM Configuration Manager > Tools > Explorer Tools > Agent Explorer
**How to Administer Agents**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Click <strong>Save</strong>.</td>
<td>Creates the Agent record. If you did not use the <strong>Select Person</strong> button to associate the agent with an existing Person record, a new Person record is automatically created for the agent.</td>
</tr>
</tbody>
</table>

**Note:** You can also add many agents at one time using the Bulk Configuration tool.

**How to Delete IPCC Enterprise Voice-Only Agents**

You logically delete agents using the Agent Explorer tool. Agents cannot be deleted from the Agent Explorer until they have been removed from any teams using the Agent Team List tool. If agents exist in script references, use the Script Reference tool to find any existing references, then use the ICM Script Editor application to delete that script. Agents still exist in the deleted objects databases until permanently deleted.

**Note:** For scripting and reporting purposes, if the script is configured to send a call directly to an agent and that agent is permanently deleted, the call/script would fail. Also, you can run historical reports for permanently deleted agents.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Delete the agent record.</td>
<td>Deletes the agent as well as the associated person.</td>
</tr>
<tr>
<td></td>
<td>Use the Agent Explorer tool in the ICM Configuration Manager to delete the agent record.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Highlight the agent and click <strong>Delete</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If this was the last or only agent record associated with the person record for this agent, then the associated person record is also deleted.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ICM Configuration Manager &gt; Tools &gt; Explorer Tools &gt; Agent Explorer</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Purge the agent from the deleted objects.</td>
<td>Permanently deletes the agent from the database.</td>
</tr>
<tr>
<td></td>
<td>Highlight the Agent table name in the Tables with Deleted Records window, then highlight the agent in the Deleted Records of the “Agent” Table window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Click <strong>Delete</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ICM Configuration Manager &gt; Tools &gt; Miscellaneous Tools &gt; Deleted Objects</td>
<td></td>
</tr>
</tbody>
</table>
How to Create an Agent Supervisor

You create an agent supervisor by simply modifying the agent record in the ICM Configuration Manager.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the Supervisor tab in the Agent Explorer tool application when creating or modifying an agent record.</td>
<td>Accesses an agent record.</td>
</tr>
<tr>
<td>2</td>
<td>Check the <strong>Supervisor Agent</strong> check box. Enter the Windows Domain name.</td>
<td>Designates the agent as a supervisor. Complete the remaining fields on this tab as described in the ICM Configuration Manager online help.</td>
</tr>
</tbody>
</table>

**Note: Important!** You must perform the configuration listed above so the supervisor can use the Barge-In and Intercept features.

How to Delete an Agent Supervisor

You delete an agent supervisor by simply modifying the agent record in the ICM Configuration Manager.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the Supervisor tab in the Agent Explorer tool application when deleting an agent record.</td>
<td>Accesses an agent record.</td>
</tr>
<tr>
<td>2</td>
<td>Uncheck the <strong>Supervisor Agent</strong> check box.</td>
<td>Agent is no longer designated as a supervisor.</td>
</tr>
</tbody>
</table>

**Note:** If you want to delete the entire record, follow the guidelines for deleting an agent record in the “How to Delete IPCC Enterprise Voice-Only Agents” section.

How to Create Agent Teams

After adding agents with the Agent Explorer tool, you can create agent teams with the Agent Team List tool.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Access the Agent Team List tool in the ICM Configuration Manager.</td>
<td>Access the Agent Team List tool.</td>
</tr>
</tbody>
</table>

**Example:**

ICM Configuration Manager > Tools > List Tools > Agent Team List
How to Administer Agents

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Click <strong>Retrieve</strong>, and then click <strong>Add</strong> to add a new agent team.</td>
<td>Allows you to begin defining a new agent team. Complete the window, adding desired agents to the team.</td>
</tr>
<tr>
<td>3</td>
<td>Click the Members tab.</td>
<td>Allows you to select agents to add to the team.</td>
</tr>
<tr>
<td>4</td>
<td>Click the Supervisor tab.</td>
<td>Allows you to designate a supervisor for the team. With IPCC Enterprise, assign both a primary and a secondary supervisor to each agent team.</td>
</tr>
</tbody>
</table>

How to Delete Agent Teams

You delete agent teams with the Agent Teams List tool. You cannot delete a team until you have removed the agent and supervisor from that team.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Access the Agent Team List tool in the ICM Configuration Manager <strong>Example:</strong> ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Agent Team List</td>
<td>Opens the Agent Team List tool.</td>
</tr>
<tr>
<td>2</td>
<td>Click <strong>Retrieve</strong> to obtain the current list of teams.</td>
<td>Displays the current teams.</td>
</tr>
<tr>
<td>3</td>
<td>Highlight the team you want to delete and click <strong>Delete</strong>.</td>
<td>Deletes the agent team.</td>
</tr>
<tr>
<td>4</td>
<td>Click <strong>Save</strong> to save your changes.</td>
<td>Saves your changes to the database.</td>
</tr>
</tbody>
</table>

How to Create Multichannel Agents

Create multichannel agents using the Administration desktops of the multichannel software. Detailed information on creating agents using Cisco Collaboration Server and/or Cisco E-Mail manager appears in the associated documentation.

How to Delete Multichannel Agents

Delete multichannel agents using the Administration desktops of the multichannel software. The agent will be deleted in each of the applications in which the agent is enabled before being deleted on ICM software. Detailed information on deleting agents using Cisco Collaboration Server and/or Cisco E-Mail Manager appears in the associated documentation.

If you choose to delete multichannel agents using the ICM Configuration Manager, you will receive an error message from ICM software recommending you delete the agent from the application. Also, run the Verify and Synch tools for the multichannel application.
### How to Configure Not Ready Reason Codes

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | In the ICM Configuration Manager, configure Not Ready reason codes | Configure the agent Not Ready reason codes in the Reason Code List tool.  
**Example:**  
ICM Configuration Manager > Tools > List Tools > Reason Code List  
**Note:** If you are using the CTI Toolkit Agent Desktop (Win32), make sure the reason codes match the codes on the desktop. ICM reason codes display in the Agent Not Ready reports, but the agent actually selects the desktop code, so these codes must match to avoid confusion. Configure predefined Not Ready reason codes so their text displays in the reports. |
| 2    | In the ICM Configuration Manager, enable the Agent event detail option. | Open the PG Explorer tool, select the PG, and select the Cisco CallManager peripheral. Then check the Agent event detail check box on the Agent Distribution tab to enable reporting on Not Ready reason codes. |
Purpose
Command or Action
ICM Configuration Manager > Tools > Explorer Tools > PG Explorer

3 Configure the Not Ready reason codes on the desktop.

Note: Refer to the CTI OS System Manager’s Guide for Cisco ICM/IPCC Enterprise & Hosted Editions for information on how to configure CTI OS Logout and Not Ready reason codes.

How to Configure Agent Features

This section describes how to perform the following tasks:

• Configure IPCC Enterprise for Redirection on No Answer situations on IP IVR and CVP/ISN
• Configure automatic wrap-up
• Configure supervisor assist and emergency alert situations

How to Configure IPCC Enterprise for Redirection on No Answer Situations on IP IVR

Note: Important! CallManager is the ICM Routing Client that ensures the call arrives at the right destination.

Recommended configuration for Redirection on No Answer situations is detailed in the table below:

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | In the ICM Configuration Manager, configure Agent Desk Settings  
**Example:**  
ICM Configuration Manager > Tools > List Tools > Agent Desk Settings List | Allows you to define the following:  
• A Redirection on No Answer time  
• Redirection on No Answer dialed number (to access the Redirection on No Answer script defined in Step 3, below)  
**Note:** The Redirection on No Answer timer is not applicable if Auto-answer is enabled since the Redirection on No Answer feature and Force Answer are mutually exclusive. If both are defined, Auto-answer will take precedence over Redirection on No Answer. |
| 2    | In the ICM Configuration Manager, set up the call type  
**Example:** | Set up the call type and associate it with the dialed number and the routing script. |
**How to Configure IPCC Enterprise for Redirection on No Answer Situations on CVP/ISN**

For IPCC Enterprise systems in which CVP/ISN is deployed, the Cisco CallManager does not control CVP/ISN and cannot send an unanswered call back to CVP/ISN for re-queuing. You configure the Re-route on Redirection on No Answer feature to only make the agent “Not Ready” when he/she does not answer a call, and use the CVP/ISN Target Requery feature to re-queue the call. Refer to the *IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition* for more details.

**Note: Important!** CallManager does not control the queuing platform (CVP/ISN); therefore, CallManager can not send the call back to CVP/ISN for re-queuing. When using CVP/ISN, CVP/ISN controls the call control.

Recommended configuration for Redirection on No Answer situations is detailed in the table below:

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the ICM Configuration Manager, configure Agent Desk Setting</td>
<td>Allows you to define the following:</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td>• A Redirection on No Answer time: Set this number less than the number set for the No Answer Timeout for the Target Requery that you set in</td>
</tr>
</tbody>
</table>

---

**Step 3**

Using the ICM Script Editor, create a routing script to handle Redirection on No Answer situations.

**Note:**

- If you configure the Redirection on No Answer timer in the ICM Agent Desk Settings, it is not necessary to configure the CallManager Call Forward No Answer fields for the agent extensions in the CallManager configuration. If you would like to configure them for cases when an agent is not logged in, set the CallManager system service parameter for CallManager Call Forward No Answer timer at least 3 seconds higher than the ICM Redirection on No Answer timer on each of the CallManager nodes.

- If you want to ensure that Redirection on No Answer calls adversely affect the service level, define the service level threshold to be less than the Redirection on No Answer timer at the call type and service.
### How to Configure Agent Features

**ICM Configuration Manager > Tools > List Tools > Agent Desk Settings List**

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>CVP/ISN (causes agent to be made unavailable after the Redirection on No Answer timer expires, but will not invoke the Redirection on No Answer mechanism to re-route the call—see Step 3, below)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Redirection on No Answer dialed number (to access the Redirection on No Answer script): Leave this field blank</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The Redirection on No Answer timer is not applicable if Auto-answer is enabled since the Redirection on No Answer feature and Force Answer are mutually exclusive. If both are defined, Auto-answer will take precedence over Redirection on No Answer.</td>
</tr>
<tr>
<td>2</td>
<td>Using the CVP/ISN VBAdmin tool, configure CVP/ISN’s ring-no-answer timeout.</td>
<td>This step causes CVP/ISN to issue a requery to ICM software if the assigned agent does not answer. In the VBAdmin tool, use the SetRNATimeout command to set the ring-no-answer timeout to a duration which is two seconds longer than the Redirection on No Answer time that was set in Step 1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Set this timeout to under 30 seconds since ICM software waits 30 seconds for CVP/ISN to return a routing label and then fails, so CVP/ISN needs to requery before this happens.</td>
</tr>
<tr>
<td>3</td>
<td>Using the ICM Script Editor, account for requeries in the routing script to handle Redirection on No Answer situations. Use the Target Requery script feature.</td>
<td>Allows you to report on Redirection on No Answer information. This script enables Requery (enable the Requery check box) on the node in the script that selects and delivers the call to the first agent. Depending on the type of node used, the Requery mechanism selects a new target from the available agents or requires additional scripting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to the <em>ICM Scripting and Media Routing Guide for Cisco ICM/IPCC Enterprise &amp; Hosted Editions</em> for information on how Requery works for the different nodes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Do not create and schedule a new Routing script for Redirection on No Answer purposes in CVP/ISN deployments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Do not create and schedule a new Routing script for Redirection on No Answer purposes in CVP/ISN deployments.</td>
</tr>
</tbody>
</table>

### Note:

- If you configure the Redirection on No Answer timer in the ICM Agent Desk Settings, it is not necessary to configure the CallManager Call Forward No Answer fields for the agent extensions in the CallManager configuration. If you would like to configure them for cases when an agent is not logged in, set the CallManager system service parameter for CallManager Call Forward No Answer timer at least 3 seconds higher than the ICM Redirection on No Answer timer on each of the CallManager nodes.
If you want to ensure that Redirection on No Answer calls adversely affect the service level, define the service level threshold to be less than the Redirection on No Answer timer at the call type and service.

How to Configure Automatic Wrap-Up

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configure Agent Desk Settings to require automatic wrap-up</td>
<td>Allows you to force agents into Wrap-up mode when they are finished with inbound or outbound calls.</td>
</tr>
<tr>
<td></td>
<td>Example: ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Agent Desk Settings List</td>
<td>Use these two fields to enable automatic wrap-up:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Work mode on Incoming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Work mode on outgoing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose either Required or Required with wrap-up data to indicate automatic wrap-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Also, enter the time, in seconds, allocated to an agent to wrap-up a call.</td>
</tr>
<tr>
<td>2</td>
<td>Configure Agent Desk Settings to require appropriate reason codes.</td>
<td>Allows you to determine when and if agents are required to enter a Reason Code when they log out or enter a Not Ready state.</td>
</tr>
</tbody>
</table>

How to Configure Supervisor Assist and Emergency Alert Situations

Recommended configuration for supervisor assist and emergency alert situations is detailed in the table below:

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the ICM Configuration Manager, configure Agent Desk Settings</td>
<td>Allows you to define the following:</td>
</tr>
<tr>
<td></td>
<td>Example: ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Agent Desk Settings List</td>
<td>- Assist call method</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Emergency alert method</td>
</tr>
<tr>
<td>2</td>
<td>In the ICM Configuration Manager, set up the call type</td>
<td>Set up the call type and associate it with the dialed number and the routing script.</td>
</tr>
<tr>
<td></td>
<td>Example: ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Call Type List</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>In the ICM Configuration Manager, configure Dialed Number for supervisor</td>
<td>Allows you to define the following:</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td>- Dialed number string</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Call type</td>
</tr>
</tbody>
</table>
### How to Configure Supervisor Features

This section explains how to configure supervisor logged-in state for CAD.

#### How to Configure Supervisor Logged-in State for CAD

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the ICM Configuration Manager, configure Agent Desk Settings for the CAD supervisor. <strong>Example:</strong> ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Agent Desk Settings List</td>
<td>Create separate desk settings for the CAD supervisor.</td>
</tr>
<tr>
<td>2</td>
<td>Leave Logout non-activity time option blank</td>
<td>Leaving this option blank keeps a supervisor logged into Cisco Agent Desktop.</td>
</tr>
</tbody>
</table>

---

**See Also**

For information about agent desk settings, agent teams, and dialed numbers, refer to the *IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition* and the ICM Configuration Manager online help.

For information about reason codes, refer to the *CTI OS System Manager’s Guide for Cisco ICM/IPCC Enterprise & Hosted Editions*.
A CAD supervisor uses Cisco Supervisor Desktop to view agent activity, silently monitor, record agent calls, send Team Performance Messages, and chat with agents and other supervisors. In order for the supervisor to barge in, intercept, or view skill statistics, Cisco Agent Desktop must be running on the supervisor's computer.

**See Also**

For information about Agent Desk Settings, refer to the *IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition* and the ICM Configuration Manager online help.

For information about Barge-in and Intercept, refer to the *CTI OS System Manager's Guide for Cisco ICM/IPCC Enterprise & Hosted Editions*.

### Using the IPCC Enterprise Agent Re-skilling Tool

#### Accessing the IPCC Enterprise Agent Re-skilling Tool

Access to the Agent Re-skilling Tool is limited to individuals with supervisor privileges.

**Note:** This tool is accessible using System IPCC or within IPCC Enterprise.

To access the Agent Re-skilling Tool using your agent name:

1. In your browser's address bar, enter: `https://<agent_reskilling_server_ip_or_dns>/reskill` you must enter will be provided to you by your administrator.
2. Press Enter. The Login page displays.
3. Enter your supervisor username and password. (Both username and password are case-sensitive.)
4. Click Login.

In certain deployments, you might also have the option of logging into the Agent Re-skilling Tool using your numeric agent ID. To log in using your agent ID:

1. In your browser's address bar, enter: `https://<agent_reskilling_server_ip_or_dns>/reskill` you must enter will be provided to you by your administrator.
2. Press Enter. The Login page displays.
3. Click the Login By Agent ID link.
**Note:** If this link does not appear on the Login Page you can only log in using your login name.

4. Enter your numeric agent ID and password. (Password is case-sensitive.)

5. Select the correct peripheral for your agent ID. Consult your administrator if you are not sure of your correct peripheral.

6. Click **Login**.

For security purposes, log out when you are finished using the Agent Re-skilling Tool. Log out by clicking the **Log Out** link at the top-right of the page. This will return you to the Login page. Sessions also time-out automatically after 30 minutes of inactivity. If your session has ended due to inactivity, you will be prompted to login again to resume using the tool.

**See Also**

For detailed information about using the Cisco IPCC Enterprise Agent Re-skilling tool, refer to the online help.

---

**Configuring Network Transfer for IVRs**

**How to Configure Network Transfer from an IP Phone**

To configure network transfer from an IP Phone, complete the following steps:

1. Define a CTI Route Point, for example “9999,” in the Cisco CallManager. Associate it with the JTAPI User that is connected to IPCC PIM in ICM software.

2. In the ICM Admin Workstation, define a Dialed Number for IPCC PIM and a call type for that dialed number. This call type can then be associated with a ICM script; for example, “NetXfer2.”

   **Note:** Do not define the labels of agents for the CallManager PG. Instead, define the labels for the VRU PIM so that the route result will be returned to VRU instead of a CallManager PG. If you do define the agent labels for the CallManager PG, the ICM Router returns the route result to the VRU PIM, if “Network Transfer Preferred” is enabled on the CallManager PG and VRU PIM returns the route result to the CallManager PG if “Network Transfer Preferred” is disabled on the CallManager PG and VRU PIM.

3. When the call is delivered to Agent 1 using the ICM Script “NetXfer1,” the agent can dial the number 9999 to send the call to another script, “NetXfer2.”
How to Configure Network Transfer from a CTI OS Desktop

To configure network transfer from a CTI OS Desktop, complete the following steps:

1. Define a “Dialed Number Plan” in ICM software. The routing client is the IPCC PIM and the dialed number will be the one defined before for the IPCC PIM (that is, IPCC_PIM.9999).

2. Set the Post Route to Yes and the Plan to International.

3. In the Agent Desk Settings, check all the Outbound access check boxes.
Chapter 5: Administering Agents

Configuring Network Transfer for IVRs
Chapter 6

Routing Voice Calls with IPCC Enterprise

This section contains the following topics:

- How to Set Up IPCC Enterprise Voice Routing, page 53
- How to Route to a Target Device with IPCC Enterprise, page 54

How to Set Up IPCC Enterprise Voice Routing

How to Configure a Device Target with IPCC Enterprise

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Add/configure IP Phone on CallManager</td>
<td>Creates device.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Create/configure a Device Target on ICM software, being sure to enter the Dialed Number associated with the IP Phone. Use this string when entering the dialed number: /devtype ciscophone/dn 9510.</td>
<td>Ensures that ICM can send this string to the CallManager to initialize the device.</td>
</tr>
</tbody>
</table>

Example:

ICM Configuration Manager > Targets > Device Target > Device Target Explorer

Step 3 | Associate the device in CallManager with the selected Global User | Maps the user and CTI Route Point. |

Setting up Duplicate Extensions in Multi-Site IPCC Enterprise Installations

You can use duplicate extensions in different sites in a multi-site IPCC Enterprise configuration. To accomplish this, you must associate the device targets with the appropriate peripheral using the /PID configuration parameter. This ensures that the device target is tied to the peripheral; other peripherals will not recognize it.
To associate a device target with a peripheral:

- Using the Device Target Explorer, add or modify single device target entries. (Use the Device Target Bulk (Insert) tool when adding a new device.)
- Set the Configuration Parameter field to /PID <xxxx>, where <xxxx> is the four-digit Peripheral ID (that is, /PID 5000). When you save this change, it takes effect immediately. You do not need to cycle the CallManager PG Node services for this to take effect.

How to Route to a Target Device with IPCC Enterprise

The following procedures outline the steps to follow each time you want to route to a new device target in IPCC Enterprise.

### On the CallManager

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a CTI Route Point on the CallManager</td>
<td>Configures the CallManager to make a route request to ICM software when the Route Point is dialed</td>
</tr>
<tr>
<td>2</td>
<td>Associate the CTI Route Point with the PG User</td>
<td>Makes the Route Point visible to ICM software</td>
</tr>
</tbody>
</table>

### Using the ICM Configuration Manager

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a new Dialed Number using the ICM Configuration Manager</td>
<td>Defines a new entry point for call routing</td>
</tr>
<tr>
<td>2</td>
<td>Add a new Call Type using the ICM Configuration Manager</td>
<td>Allows you to categorize calls and route them appropriately</td>
</tr>
<tr>
<td>3</td>
<td>Associate the Dialed Number with the ICM Call Type</td>
<td>Allows you to map the Dialed number to a routing script</td>
</tr>
<tr>
<td>4</td>
<td>Create a new routing script using the ICM Script Editor</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Associate the Call Type with the routing script</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** In a CallManager cluster, be aware that two routing clients must not share the same CTI Route Point. Each routing client must use distinct CTI Route Points in a CallManager cluster.

How to Enable Subskill Peripherals and Skill Groups

Only use base skill groups for IPCC Enterprise configurations; therefore, a default is set at the peripheral level, ensuring that any new skill group created will be base-only.
See Also

For more information about creating routing scripts, refer to the *ICM Scripting and Media Routing Guide for Cisco ICM/IPCC Enterprise & Hosted Editions* and the ICM Script Editor online help.

For more information about configuring IPCC Enterprise, refer to the *IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition*. 
The Dialed Number Plan

Note: The Dialed Number Plan is only applicable to the Voice media.

This section contains the following topics:

- About the Dialed Number Plan, page 57
- About Dialed Number Plan Values, page 58
- How to Configure the Dialed Number Plan, page 61

About the Dialed Number Plan

The Dialed Number Plan allows you to manage and track agent-initiated calls.

Understanding the Dialed Number Plan

The Dialed Number Plan consists of a number of entries intended to accommodate the different types of calls agents might make. Each entry contains a Wildcard string that is used to match a number that an agent might dial. Each digit of the string an agent dials is processed until a matching dial plan entry is found. Once found, the selected trunk group or resource is used to complete the call.

Each entry contains additional information indicating how calls matching that wildcard string will be handled.

For example, dialing a 9 to receive an outside line on a PBX or ACD would be specified in the dial plan. All patterns that reference network trunks might begin with a ‘9’ digit. Subsequent digits might be ‘1’ for long distance patterns, ‘0’ for operator assisted or international calls, ‘2’ through ‘9’ to specify an area code. The dial plan allows a customer to have multiple phone carrier trunks terminated at the PBX or ACD for different outbound call types. A customer might choose MCI as the long distance carrier while AT&T is the international carrier, and Bell Atlantic is the local carrier. The dial plan configuration would be used to determine which carrier to use based on the patterns defined within the dial plan.
Note: Do not confuse the Dialed Number Plan Bulk Insert tool with the Dialed Number Bulk Insert tool.

You use the Dialed Number Plan to:

• Ensure agent-initiated calls are routed by an ICM routing script
• Set up basic dialing substitutions

Using the Dialed Number Plan to Ensure ICM Routing of Agent Calls

The most common and powerful use of the Dialed Number Plan is to ensure that agent-initiated calls are routed through ICM software. In this case, you must specify that you want to request a PostRoute for the call and specify a dialed number associated with a routing script designed to handle the type of agent call.

Use this method of configuring the Dialed Number Plan for:

• Agent-to-agent transfers
• Agent-to-agent calling
• Agent-initiated outbound calls

Using the Dialed Number Plan to Set Up Basic Dialing Substitutions

You can also use the Dialed Number Plan to specify basic dialing substitutions. In this scenario, you identify a Wildcard pattern that will match the number dialed by an agent. However, you do not request a Post Route and the call is not matched to a Dialed Number, and thus not routed by ICM software. Instead, you enter the string you want to be dialed in the Dial String field. That string is used to place the agent’s call.

Using the Dialed Number Plan in this way is most useful for setting up such things as:

• Speed Dial
• Using alphanumeric characters to dial from a soft phone

About Dialed Number Plan Values

Each field on the Dialed Number Plan dialog box is defined in the ICM Configuration Manager online help. This section provides additional information about these fields and how you can use them to set up agent dialing for your contact center.

The window below illustrates a Dialed Number Plan entry that specifies ICM routing for the agent call:
Figure 1: Dialed Number Plan Entry Specifying ICM Routing for the Agent Call

Wildcard Pattern

The Wildcard pattern you enter can contain letters, digits, and number signs (#). It can also include these wildcard characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Represents any single alphanumeric character.</td>
</tr>
<tr>
<td>!</td>
<td>Represents any string of character and can appear only at the end of a pattern.</td>
</tr>
</tbody>
</table>

Routing Client

The Routing Client field lets you specify the routing client for the agent call. In IPCC Enterprise configurations, set this field to identify the CallManager PG.

Post Route

Use the Post Route field to specify whether this type of agent call will be sent to a routing script. If you set Post Route to YES, you must also enter a Dialed Number that is associated with a routing script designed to handle the type of agent call.

Dialed Number

Use the Dialed Number field if you’ve set the Post Route field to Yes, indicating that you want an ICM routing script to handle this agent call.

Dial String

Use the Dial String field only when you set the Post Route field to No, indicating that you want to use this entry for dialing substitutions. This field cannot be used when PostRoute is selected to send the call to an ICM routing script.

The Dial String field can contain wildcard characters used to translate the dialed number string provided by the agent to the dial string that will be delivered to the switching platform. The following table describes the wildcard characters that might appear in the DialString field.

<table>
<thead>
<tr>
<th>Wildcard Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Copy all remaining characters in the agent-provided dialed number string</td>
</tr>
<tr>
<td>?</td>
<td>Copy character at the position identified</td>
</tr>
</tbody>
</table>
### Wildcard Character Description

<table>
<thead>
<tr>
<th>Wildcard Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X or x</td>
<td>Excludes the character in the agent supplied dialed number string at the</td>
</tr>
<tr>
<td></td>
<td>position identified from the offset as defined from the beginning of the</td>
</tr>
<tr>
<td></td>
<td>DialedNumberPlan DialString field</td>
</tr>
</tbody>
</table>

The following table provides examples of the translation of a DialedNumber string specified by an agent to a resultant DialString as defined by the DialString entry of the matching DialedNumberPlan entry.

<table>
<thead>
<tr>
<th>Agent Dialed Number</th>
<th>DialedNumber Plan Dial String</th>
<th>Dial string result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5133</td>
<td>6100</td>
<td>6100</td>
<td>Direct substitution.</td>
</tr>
<tr>
<td>5133</td>
<td>6X???</td>
<td>6133</td>
<td>Partial replacement.</td>
</tr>
<tr>
<td>5133</td>
<td>!</td>
<td>5133</td>
<td>Complete Copy.</td>
</tr>
<tr>
<td>5133</td>
<td>9275!</td>
<td>9275133</td>
<td>Prefix Addition.</td>
</tr>
<tr>
<td>5133</td>
<td>62XX??</td>
<td>6233</td>
<td>First 2 char substitution.</td>
</tr>
<tr>
<td>5133</td>
<td>???</td>
<td>5133</td>
<td>Complete Copy.</td>
</tr>
<tr>
<td>5133</td>
<td>?XXX000</td>
<td>5000</td>
<td>Retain first character; substitute the remaining characters.</td>
</tr>
<tr>
<td>2755100</td>
<td>????200</td>
<td>2755200</td>
<td>Replace last three characters.</td>
</tr>
<tr>
<td>2755100</td>
<td>!220</td>
<td>2755100220</td>
<td>Suffix addition.</td>
</tr>
</tbody>
</table>

### Using the Dial String for Speed Dialing

You can configure Static Dial String translations to provide speed dial capabilities. Here, you enter the abbreviated string an agent would dial in the Wildcard pattern. You enter the actual target number in the Dials String of the entry.

When a dialed number provided by an agent matches the Wildcard pattern of the Dialed Number Plan entry, the Dial String configured entry will be sent in place of the agent supplied Dialed Number string.

The following table provides an example of a speed dial configuration.

<table>
<thead>
<tr>
<th>Agent Dialed Number</th>
<th>Dial String</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>133</td>
<td>919782755133</td>
<td>919782755133</td>
</tr>
</tbody>
</table>

### Using the Dial String for Alphanumeric Substitutions

You can use the Dialed Number Plan to allow agents to specify an alphanumeric string when dialing. For instance, an agent might dial “SALES” when calling the sales department rather than a numeric value that might be harder to remember.

To configure an alphanumeric substitution, configure the alphanumeric dial string as the Wildcard pattern and the target number as the Dial String of the DialedNumberPlan entry. When a dialed
number provided by an agent matches the wildcard pattern of the Dialed Number Plan entry, the configured Dial String is sent in place of the agent supplied string.

Wildcard characters can be combined with this feature to allow Alpha prefixes to be added to numbers to identify the location of the number. Examples are shown the following table:

<table>
<thead>
<tr>
<th>Agent Dialed Number</th>
<th>DialedNumberPlan Dial String</th>
<th>Resultant Dial String</th>
</tr>
</thead>
<tbody>
<tr>
<td>SALES</td>
<td>919782755100</td>
<td>919782755100</td>
</tr>
<tr>
<td>BOS5133</td>
<td>9782755133</td>
<td>9782755133</td>
</tr>
<tr>
<td>FL14Office1433</td>
<td>5133</td>
<td>5133</td>
</tr>
</tbody>
</table>

Dial Number Type Plan

The Dial Number Type Plan lets you specify the type of call that will be placed. These include:

<table>
<thead>
<tr>
<th>Dialed Number Plan</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>International</td>
<td>Allows agents to place calls classified as international calls.</td>
</tr>
<tr>
<td>National</td>
<td>Allows agents to place calls classified as national long distance calls.</td>
</tr>
<tr>
<td>Local</td>
<td>Allows agents to place calls classified as national local calls.</td>
</tr>
<tr>
<td>Operator Assisted</td>
<td>Allows agents to place calls classified as operator assisted calls.</td>
</tr>
<tr>
<td>PBX</td>
<td>Allows agents to place calls to agents on the same peripheral.</td>
</tr>
</tbody>
</table>

The options for this field map exactly to the options on the Agent Desk Settings List window. ICM software checks the Agent Desk Settings for the agent placing the outbound call. Agent Desk Settings define which types of calls agents can and cannot make. If the Agent Desk Settings for an agent prevent him or her from placing a particular type of call (for instance, international), the call will not be placed.

How to Configure the Dialed Number Plan

How to Use the Dialed Number Plan to Ensure ICM Routing of Agent Calls

Follow these steps to configure a Dialed Number Plan entry to route an agent call through ICM software.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a routing script to handle each type of agent-initiated call using the ICM Script Editor.</td>
<td>Ensures agent-initiated calls are routed appropriately by ICM software. The script can target agent, services, or skill groups using ICM script nodes. Once a target is chosen, the associated label is sent back to the requesting peripheral. The label value will be substituted for the</td>
</tr>
</tbody>
</table>
## How to Configure the Dialed Number Plan

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Purpose</strong></td>
<td><strong>Action</strong></td>
</tr>
<tr>
<td>2</td>
<td>In the ICM Configuration Manager, set up the call type.</td>
<td>Set up the call type and associate it with the dialed number to target to routing scripts.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Call Type List</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Insert an entry in the Dialed Number Plan dialog box. Using the fields in this window, make sure to:</td>
<td>Matches the agent’s dialed string to a Dialed Number. This ensures the agent’s call will be routed by an ICM routing script.</td>
</tr>
<tr>
<td></td>
<td>• Indicate the appropriate Wildcard character.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Set the Post Route text box to <strong>Yes</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Select a valid Dialed Number associated with the routing script used to route the agent call.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Set the Dial Number Type Plan to indicate the type of call.</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>ICM Configuration Manager &gt; Tools &gt; Bulk Configuration &gt; Insert &gt; Dialed Number Plan Bulk Insert</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Ensure Agent Desk Settings are set to identify the types of calls agents can place.</td>
<td>Ensures that agents are allowed to or restricted from placing different types of outbound calls.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Agent Desk Settings List</td>
<td></td>
</tr>
</tbody>
</table>

### How to Use the Dialed Number Plan to Set Up Basic Dialing Substitutions for Agent Calling

Follow these steps to configure a Dialed Number Plan entry to route an agent call through ICM software.
### Purpose

Matches the agent’s dialed string to the Dial String indicated in the entry. This Dial String will be used to place the call (the call will not be routed by ICM software).

### Action

| 1 | Insert an entry in the Dialed Number Plan dialog box. Using the fields in this window, make sure to:  
• Indicate the appropriate Wildcard character.  
• Set the PostRoute field to No.  
• Identify a valid Dial String used to place the call.  
• Set the Dial Number Type Plan to indicate the type of call.  
Example:  
ICM Configuration Manager > Tools > Bulk Configuration > Insert > Dialed Number Plan Bulk Insert |
| --- | --- |
| 2 | Ensure Agent Desk Settings are set to identify the types of calls agents can place.  
Example:  
ICM Configuration Manager > Tools > List Tools > Agent Desk Settings List |

### See Also

For more information on ICM Routing Scripts, refer to the *ICM Scripting and Media Routing Guide for Cisco ICM/IPCC Enterprise & Hosted Editions*.

For more information on Agent Desk Settings, see About Agent Desk Settings (page 17).
Part 3: Performing Administrative Tasks with the Cisco IPCC Enterprise Web Administration Tool

The IPCC Enterprise Web Administration Tool is a browser-based application designed for use by IPCC administrators and system administrators.

Note: The information in this part only pertains to System IPCC deployments.

The Web Administration Tool lets you remotely configure and administer key aspects of your IPCC Enterprise system, including:

- The machines in your IPCC deployment
- Agents, agent teams, skill groups, and desktop settings
- Dialed numbers, call types, and call variables
- Multichannel call handling
- Service level criteria for call handling

Note: Refer to the Cisco IPCC Enterprise Web Administration Tool online help for detailed information about using this tool.
About the IPCC Enterprise Web Administration Tool

How to Log in to the IPCC Web Administration Tool

Access to the IPCC Web Administration Tool is limited to individuals with IPCC administrator privileges. To access the IPCC Web Administration Tool:

**Step 1**
In your browser’s address bar, enter: https://<Administration & WebView Reporting machine DNS or IP address>/ipccAdmin.

**Step 2**
Press <Enter>. The Login page displays.

**Note:** The first time you access the IPCC Web Administration Tool you may be prompted to accept a security certificate.

**Step 3**
Enter your IPCC administrator username and password. Passwords are case-sensitive.
Working with List Pages

About List Pages

When you select a menu item in the Web Tool, records of the type you selected (e.g., agents or skill groups) are initially displayed on a "list" page. From the list page you can then choose a record to view in detail, edit, or delete.

List pages also allow you to filter and sort records as described below.

How to Sort Records on a List Page

By default, list pages display records sorted in ascending order by the first data column.

Records that begin with:

- Numeric characters are listed before records that begin with alpha characters.
- Upper-case characters are listed before records that begin with lower-case characters.

To:

- Sort data in a column in descending order, click that column's header until a downward arrow appears.
- Sort data by a different column, click that column's header.

How to Filter Records on a List Page

List pages include a series of fields at the top of the page that can be used to further filter the records they initially return.
Filters are "sticky," meaning that once applied they remain in effect for the current session even if you leave and then later return to that page. To remove a filter, click the Clear button on the right side of the filter, or enter new filter criteria.

To filter records on a list page:

**Step 1** Specify a column name, operator, and value in the filter fields at the top of a list page. Note that values are case-sensitive. Some filters do not need a require a value (for example, the boolean filter "like Supervisor" in the Agent List page).

When using the operators Contains, Doesn't Contain, Begins With, and Ends With, as desired you can use the following wild-cards in your filter:

<table>
<thead>
<tr>
<th>Wild-card</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ (underscore)</td>
<td>match 1 character</td>
</tr>
<tr>
<td>% (percent)</td>
<td>match 0 or more characters</td>
</tr>
<tr>
<td>[ ] (straight brackets)</td>
<td>match any character within the brackets (including _ or %)</td>
</tr>
<tr>
<td>a-z</td>
<td>matches a range of characters from a-z</td>
</tr>
<tr>
<td>^a-z</td>
<td>matches all characters except a-z</td>
</tr>
</tbody>
</table>

**Note:** Wild-cards cannot be used to filter lists of Active Directory accounts names.

**Step 2** Click the Go button.

---

### How to Delete Multiple Records on a List Page

Based on your privileges, you may be able to delete records from a list page. To do this, select the record's check box and click Delete.

When you are deleting multiple records, list pages delete them in blocks of 200. If an error is encountered (for example, a record cannot be removed because of a dependency) the delete will terminate in the block of 200 where the error occurred. For example, if the error occurs in record 205, the first 200 will be deleted, but not the next or subsequent blocks of 200.
How to Administer Agents

The information in the following sections assumes that you are already working within the IPCC Enterprise Web Administration tool, unless otherwise stated.

This section contains the following topics:

- Page Access and Use, page 71
- How to Create an Agent, page 71
- How to Delete an Agent, page 72
- Agents Fields, page 72
- How to Bulk Create Agents, page 73
- How to Configure Global Agent Options, page 74
- How to Create a Supervisor Agent, page 75
- Page Access and Use, page 75
- How to Create an Agent Team, page 75
- How to Delete an Agent Team, page 76
- Agent Team Fields, page 76
- Administering Multichannel Agents, page 77

Page Access and Use

Use the Agents page to create, edit, and delete agents and supervisor agents, and to define agent properties such as passwords, voice skill group associations, and desk settings. To open the page, from the Web Administration Tool menu, select Agent Management > Agents. Initially, the page lists all agents defined in the system. You can further sort or filter the list (page 69), as desired.

How to Create an Agent

To create an agent:

Step 1 On the Agent list page, click Create.
**Step 2** Enter a first, last, and login name for the agent. Names can be up to 24 characters long.

**Step 3** Complete fields as described in the Agents fields table below.

**Step 4** Click Save.

Once you've created an agent, you can assign that user as the member of an Agent Team, and to one or more Skill Groups.

### How to Delete an Agent

To delete one or more agents:

**Step 1** On the Agent list page, select the record(s) you want to delete.

**Step 2** Click Delete.

**Step 3** A message prompts you to confirm the deletion. Click OK.

**Note:** Deleting an agent or agent supervisor will automatically remove that agent from any associated teams or skill groups, including multichannel skill groups.

### Agents Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name, First</td>
<td>The agent's first name.</td>
<td>Up to 24 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Name, Last</td>
<td>The agent's first name.</td>
<td>Up to 24 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Name, Login</td>
<td>A unique Login name for the agent.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Allow Login</td>
<td>Allows the agent to login to the IPCC system.</td>
<td>Checked or unchecked.</td>
<td>Checked</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** The IPCC database is case-insensitive in determining whether an agent login name is unique—for example, it considers "joe_smith" and "JOE_SMITH" to be the same. Further, agent login to agent desktop software (CAD or CTI OS) is not case-sensitive. However, supervisor agent login to the Agent Re-skilling Tool IS case-sensitive -- users of this tool must login using the exact mix of case with which their login name was created.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team</td>
<td>The supervisory team with which the agent is associated.</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the agent.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Skill Group</td>
<td>The voice skill group(s) of which the agent is a member. Changes to an agent's skill group membership take place immediately within the agent's current session.</td>
<td>Click Add to select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Team</td>
<td>The supervisory team with which the agent is associated.</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the agent.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Skill Group</td>
<td>The voice skill group(s) of which the agent is a member. Changes to an agent's skill group membership take place immediately within the agent's current session.</td>
<td>Click Add to select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Password</td>
<td>The agent's login password.</td>
<td>Up to 32 characters. Must be 7 bit printable ASCII.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Note:</td>
<td>Skill groups for non-voice media routing domains (e.g., e-mail, chat) do not display in the IPCC Web Configuration Tool. To enable an agent for non-voice and assign an agent to a non-voice skill group, you must do it through your multichannel application administration tool.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Desk Setting</td>
<td>The desktop settings to be associated with the agent. The Default is the default desk setting as specified in the Agent Global Options page.</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Indicates whether or not the agent is a supervisor.</td>
<td>Checked or unchecked.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>WebView Reporting</td>
<td>Supervisor agents can be granted Supervisor-level access to WebView reporting by selecting their Active Directory account name. If blank, the supervisor does not have WebView privileges.</td>
<td>Click Add and select from list.</td>
<td>Blank</td>
<td>No</td>
</tr>
<tr>
<td>Agent State Trace</td>
<td>Indicates whether agent state trace data is collected for the agent. Agent trace data is the record of each state the agent passes through. Because tracking agent state carries resource overhead, it is suggested that this option only be selected when there is a specific need to track a particular agent.</td>
<td>Checked or unchecked.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
</tbody>
</table>

### How to Bulk Create Agents

In addition to creating agents one at a time, you can also bulk load agent records previously outputted to a CSV (comma separated values) file. The CSV records must follow the format:
FirstName, LastName, LoginName, IsLoginEnabled (true or false), TeamName, Description, Password, IsSupervisor (yes or no), DeskSettingName, IsStateTraceEnabled (yes or no)

Note: In the format example above, true/false can also be used in place of yes/no. Do not include spaces before column values. If values specified for TeamName or DeskSettingName do not match values already defined in the database, those values will be dropped during import.

The Bulk Import may take a long time depending on the number of agents being imported. Only one bulk import operation can run at a time. If another user tries to initiate a bulk import while an import is already in progress, he/she will be notified of the fact. That user can try again later after the current import operation is completed. Once initiated, a bulk load will continue even if you log out or your session times out.

During the import operation, a progress page displays indicating the number of agents created so far. If you want, you can navigate to other pages to perform other tasks. At the end of the operation, the results of the import are shown, indicating the number of agents successfully created and/or errors.

The results page is discarded once it has been viewed or when your user session expires. If the system is low on memory, to save on system resources, the results page may be discarded before you get a chance to view it. If this happens, look at the Agents list page to see if your import was successful.

To bulk agent records:

---

### Step 1
Open the CSV agent record files and select and copy the agent records.

### Step 2
On the Agent list page, click Bulk Create.

### Step 3
Paste agent records into the Import data field.

### Step 4
Optionally, to test the validity of your records without writing data to the database, select Verify Syntax (checked by default). Clear this check box if you do not want to test data before writing to the database.

### Step 5
Click Create.

---

How to Configure Global Agent Options

Global agent options allow you to define defaults for certain agent record input, such as the minimum password length. To configure global agent options:

---

### Step 1
On the Agents list page, click Global Options.

### Step 2
Optionally, specify a minimum length for agent passwords. A new minimum length will affect new but not existing records.

### Step 3
Optionally, specify the default Desk Setting to be used during new agent creation.
How to Create a Supervisor Agent

To create a supervisor agent supervisor:

**Step 1** On the Agent list page, click Create.

**Step 2** Enter a first, last, and login name for the agent. Names can be up to 24 characters long.

**Step 3** Complete fields as described in the Agents fields table below.

**Step 4** Check the Supervisor check box.

**Step 5** Optionally, to give the user Supervisor-level access to Webview reporting, click Browse next to WebView Reporting User Account and select that user's Active Directory account.

**Step 6** Click Save.

Once you have created a supervisor agent, you can assign that user to be the supervisor of an Agent Team.

Page Access and Use

Use the Agent Teams page to create, edit, and delete agent teams, and to assign agents and supervisors to a team. To open the page, from the Web Administration Tool menu, select Agent Management > Teams. Initially, the page lists all agent teams defined in the system. You can further sort or filter the list (page 69), as desired.

How to Create an Agent Team

To create an agent team:

**Step 1** On the Agent Team list page, click Create.

**Step 2** Enter a unique name for the team.

**Step 3** Complete fields as described in the Agent Team Fields table below.

**Step 4** To assign agents to the team, click the Add button below the Agents box and select one or more agents.

**Step 5** To assign additional supervisors to a team, click the Add button below the Supervisors box and select one or more agent supervisors.
Step 6  Click Save.

How to Delete an Agent Team

To delete one or more agent teams:

Step 1  On the Agent Teams list page, select the record(s) you want to delete.
Step 2  Click Delete.
Step 3  A message prompts you to confirm the deletion. Click OK.

Agent Team Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Supervisor Script</td>
<td>The dialed number for the agent team. This is the number that is dialed when an agent selects Supervisor Assist or Emergency Assist from agent desktop software.</td>
<td>Select from list.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Dialed Number</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>A description of the team.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Agents</td>
<td>Individual agents associated with this team.</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Primary Supervisor</td>
<td>The team's primary supervisor.</td>
<td>Select from list.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Supervisors</td>
<td>The team's secondary supervisor(s). If you are allowing Supervisor Assist or Emergency Assist, these supervisors will be contacted if the primary is unavailable.</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>
Administering Multichannel Agents

How to Create Multichannel Agents

Create multichannel agents using the Administration desktops of the multichannel software. Detailed information on creating agents using Cisco Collaboration Server and/or Cisco E-Mail manager appears in the associated documentation.

**Note:** This task is not currently available using the IPCC Enterprise Web Administration Tool, but is documented here since it is an administrative task you might need to perform.

How to Delete Multichannel Agents

Delete multichannel agents using the Administration desktops of the multichannel software. The agent will be deleted in each of the applications in which the agent is enabled before being deleted on ICM software. Detailed information on deleting agents using Cisco Collaboration Server and/or Cisco E-Mail Manager appears in the associated documentation.

If you choose to delete multichannel agents using the ICM Configuration Manager, you will receive an error message from ICM software recommending you delete the agent from the application. Also, run the Verify and Synch tools for the multichannel application.

**Note:** This task is not currently available using the IPCC Enterprise Web Administration Tool, but is documented here since it is an administrative task you might need to perform.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Disable the agent from the multichannel application. For instance, use Collaboration Server Administration to disable a Collaboration agent.</td>
<td>Ensures the agent is not active on the multichannel application.</td>
</tr>
<tr>
<td>2</td>
<td>In the ICM Configuration Manager, delete the agent using the Agent Explorer.</td>
<td>Deletes the agent record from the ICM database.</td>
</tr>
<tr>
<td>3</td>
<td>In the ICM Configuration Manager, delete the person record.</td>
<td>Deletes the person record associated with the agent from the ICM database.</td>
</tr>
</tbody>
</table>

**See Also**

For information about the ICM Configuration Manager, refer to the ICM Configuration Manager online help.

For information about agent features, see Configuring CTI OS and CAD Desktop Features (page 23).

For information about supervisor features, see About Configuring Supervisor Features (page 27).
For information about bulk loading agents, refer to the *IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition*.

For information about multichannel agents, refer to the *Cisco Collaboration Server Administration Guide for Cisco ICM/IPCC Enterprise & Hosted Editions* and online help and the *Cisco E-Mail Manager Administration Guide for Cisco ICM/IPCC Enterprise & Hosted Editions* and online help.

For information about database verify and sync, refer to the *Cisco Collaboration Server Administration Guide for Cisco ICM/IPCC Enterprise & Hosted Editions* and online help.
Chapter 11

How to Configure CTI OS and CAD Desktop Features

The information in the following sections assumes that you are already working within the IPCC Enterprise Web Administration tool, unless otherwise stated.

This section contains the following topics:

- Page Access and Use, page 79
- How to Create a Desk Setting, page 79
- How to Delete a Desk Setting, page 80
- Desk Settings Fields, page 80
- Page Access and Use, page 81
- How to Create a Not Ready Reason Code, page 82
- How to Delete a Not Ready Reason Code, page 82
- Reason Code Fields, page 82
- How to Configure Supervisor Features, page 83
- Using the IPCC Enterprise Agent Re-Skilling Tool, page 83
- Configuring Network Transfer for IVRs, page 84

Page Access and Use

Use the Desk Settings page to create, edit, and delete agent desk settings. To open the page, from the Web Administration Tool menu, select Agent Management > Desk Settings. Initially, the page lists all desk settings defined in the system. You can further sort or filter the list (page 69), as desired.

How to Create a Desk Setting

To create a Desk Setting record:

**Step 1**
On the Desk Settings list page, click Create.

**Step 2**
Enter unique name for the record up to 24 characters, alphanumeric, period, and underscore characters only.
Step 3 Complete fields as described in the Desk Settings Fields table below.

Step 4 Click Save.

How to Delete a Desk Setting

To delete one or more desk settings:

Step 1 On the Desk Setting list page, select the record(s) you want to delete.

Note: You cannot delete a Desk Setting if it is being referenced by an Agent record or if it is specified as the Default Desk Setting in the Agents Global Options page.

Step 2 Click Delete.

Step 3 A message prompts you to confirm the deletion. Click OK.

Desk Settings Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Ring no answer time</td>
<td>The maximum number of seconds IPCC will allow a call to ring at the agent's station before redirecting the call. This can be from 1 to 120 seconds.</td>
<td>1 to 120</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Ring no answer dialed number</td>
<td>Identifies the dialed number for a new re-route destination in the case of a ring no answer. The selection list consists of the dialed numbers configured for the system.</td>
<td>Select from list</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Logout non-activity time</td>
<td>The number of seconds of agent inactivity while in the not ready state before IPCC will logout the agent. A blank entry will disable the timer.</td>
<td>10 to 7200</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Work mode on incoming</td>
<td>Indicates whether the agent is allowed or required to enter work mode after an incoming call.</td>
<td>Select from Required, Optional, Not Allowed, and</td>
<td>Optional</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Page Access and Use

Use the Reason Codes page to create, edit, and delete Not Ready Reason Codes. To open the page, from the Web Administration Tool menu, select Agent Management > Reason Codes. Initially, the page lists all Not Ready reason codes defined in the system. You can further sort or filter the list (page 69), as desired.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work mode on outgoing</td>
<td>Indicates whether the agent is allowed or required to enter work mode after an outgoing call.</td>
<td>Select from Required, Optional, and Not Allowed.</td>
<td>Optional</td>
<td>Yes</td>
</tr>
<tr>
<td>Wrap up time</td>
<td>The amount of time in seconds allocated to an agent to wrap up the call.</td>
<td>1 to 7200</td>
<td>7200</td>
<td>No</td>
</tr>
<tr>
<td>Assist call method</td>
<td>Indicates whether IPCC will create a consultative call or a blind conference call for the supervisor assistance request.</td>
<td>Select from consultative call or blind conference call.</td>
<td>Consult</td>
<td>No</td>
</tr>
<tr>
<td>Emergency alert method</td>
<td>Indicates whether IPCC will create a consultative call or a blind conference call for an emergency call request.</td>
<td>Select from consultative call or blind conference call.</td>
<td>Consult</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the desk setting.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Auto answer</td>
<td>Indicates calls to the agent are automatically answered.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Idle reason required</td>
<td>Indicates the agent must enter a Not Ready reason before entering the Idle state.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Logout reason required</td>
<td>Indicates the agent must enter a reason before logging out.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Auto record on emergency</td>
<td>Specifies that a record request (a request to record the call) is automatically sent when an emergency call request starts.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Outbound Access</td>
<td>For deployments where agents can make outbound calls, determines the type of outbound calls they can make.</td>
<td>Select one or more from International, National, Local private network, Operator assisted, and PBX.</td>
<td>Private selected</td>
<td>No</td>
</tr>
</tbody>
</table>
### How to Create a Not Ready Reason Code

**Step 1**  
On the Reason Codes list page, click Create.

**Step 2**  
Enter a unique number for the code, up to ten digits.

**Step 3**  
Enter the reason text to display (in reports and in agent desktops) when that reason code is indicated.

**Step 4**  
Optionally, enter an internal description for the reason code.

**Step 5**  
Click Save.

**Note:** Reason codes created in IPCC are not automatically created in CTI OS. They must be created there as well. Until then they will not be available in agent desktops.

### How to Delete a Not Ready Reason Code

To delete one or more reason codes:

**Step 1**  
On the Reason Codes list page, select the record(s) you want to delete.

**Step 2**  
Click Delete.

**Step 3**  
A message prompts you to confirm the deletion. Click OK.

**Note:** Reason codes deleted from IPCC are not automatically deleted from CTI OS. They must be deleted from CTI OS as well. Otherwise they continue to remain available in agent desktops.

### Reason Code Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason Code</td>
<td>Code to be associated with a specific agent desktop event.</td>
<td>Unique number up to 10 digits.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Reason Code Text</td>
<td>Display text associated with the code in reports.</td>
<td>Up to 40 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>
How to Configure Supervisor Features

This section explains how to configure supervisor logged-in state for CAD.

How to Configure Supervisor Logged-in State for CAD

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the IPCC Enterprise Web Administration Tool, configure Agent Desk Settings for the CAD supervisor.</td>
<td>Create separate desk settings for the CAD supervisor.</td>
</tr>
<tr>
<td>2</td>
<td>Leave Logout non-activity time option blank</td>
<td>Leaving this option blank keeps a supervisor logged into Cisco Agent Desktop.</td>
</tr>
<tr>
<td></td>
<td>A CAD supervisor uses Cisco Supervisor Desktop to view agent activity, silently monitor, record agent calls, send Team Performance Messages, and chat with agents and other supervisors. In order for the supervisor to barge in, intercept, or view skill statistics, Cisco Agent Desktop must be running on the supervisor's computer.</td>
<td></td>
</tr>
</tbody>
</table>

See Also

For information about Barge-in and Intercept, refer to the *CTI OS System Manager's Guide for Cisco ICM/IPCC Enterprise & Hosted Editions*.

Using the IPCC Enterprise Agent Re-Skilling Tool

Accessing the IPCC Enterprise Agent Re-Skilling Tool

Access to the Agent Re-skilling Tool is limited to individuals with supervisor privileges.

**Note:** This tool is accessible using System IPCC or within IPCC Enterprise.

To access the Agent Re-skilling Tool using your agent name:

1. In your browser’s address bar, enter: `https://<agent_reskilling_server_ip_or_dns>/reskill` you must enter will be provided to you by your administrator.
2. Press **Enter**. The Login page displays.
3. Enter your supervisor username and password. (Both username and password are case-sensitive.)
4. Click **Login**.
In certain deployments, you might also have the option of logging into the Agent Re-skilling Tool using your numeric agent ID. To log in using your agent ID:

1. In your browser's address bar, enter: https://<agent_reskilling_server_ip_or_dns>/reskill you must enter will be provided to you by your administrator.

2. Press Enter. The Login page displays.

3. Click the Login By Agent ID link.

   **Note:** If this link does not appear on the Login Page you can only log in using your login name.

4. Enter your numeric agent ID and password. (Password is case-sensitive.)

5. Select the correct peripheral for your agent ID. Consult your administrator if you are not sure of your correct peripheral.

6. Click Login.

For security purposes, log out when you are finished using the Agent Re-skilling Tool. Log out by clicking the Log Out link at the top-right of the page. This will return you to the Login page. Sessions also time-out automatically after 30 minutes of inactivity. If your session has ended due to inactivity, you will be prompted to login again to resume using the tool.

**See Also**

For detailed information about using the Cisco IPCC Enterprise Agent Re-skilling tool, refer to the online help.

### Configuring Network Transfer for IVRs

System IPCC does not support network transfer for IVRs.
How to Work with Dialed Numbers

The information in the following sections assumes that you are already working within the IPCC Enterprise Web Administration tool, unless otherwise stated.

This section contains the following topics:

- Page Access and Use, page 85
- How to Create a Dialed Number, page 85
- How to Delete a Dialed Number, page 86
- Dialed Number Fields, page 86

Page Access and Use

Use the Dialed Numbers page to create, edit, and delete dialed numbers and associate them with call types. To open the page, from the Web Administration Tool menu, select Contact Management > Dialed Numbers. Initially, the page lists all dialed numbers defined in the system. You can further sort or filter the list (page 69), as desired.

How to Create a Dialed Number

To create a dialed number:

1. **Step 1** On the Dialed Numbers list page, click Create.
2. **Step 2** Enter unique name for the dialed number up to 24 characters, alphanumeric, period, and underscore characters only.
3. **Step 3** Complete fields as described in the Dialed Number Fields table below.
4. **Step 4** Click Add to specify the call types and other dialing information to be associated with this dialed number.

**Note:** The order of the entries in the dialed number mapping table reflects the order in which call types are processed for the DN.
Step 5  Click Save.

How to Delete a Dialed Number

To delete one or more dialed numbers:

Step 1  On the Dialed Number list page, select the record(s) you want to delete.

Note: You cannot delete a dialed number that is referenced in a script. This reference must be removed before the skill group can be deleted.

Step 2  Click Delete.

Step 3  A message prompts you to confirm the deletion. Click OK.

Dialed Number Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Media routing domain</td>
<td>The media routing domain associated with the dialed number.</td>
<td>Select from Blended Collaboration, Cisco Voice, Email, Multi Session Chat, or Single Session Chat</td>
<td>Cisco_Voice</td>
<td>Yes</td>
</tr>
<tr>
<td>Outbound</td>
<td>If the Media Routing Domain is voice, optionally select Outbound to create an outbound dialed number.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Dialed number string</td>
<td>For voice MRD only, the string value by which the Agent/IVR Controller identifies this dialed number. This must be the value the Agent/IVR Controller uses for calls to this number. For example: 8005551212.</td>
<td>Up to 32 characters</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------</td>
<td>----------</td>
<td>-----------</td>
</tr>
<tr>
<td>Script Selector</td>
<td>For non-voice MRDs only, the application-specific string that causes an IPCC script to run.</td>
<td>Up to 32 characters</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>For CCS, this value must be the script selector value hard-coded in the CCS callform used by the media routing domain you selected.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>For CEM, this value must be <code>&lt;E-Mail Manager Instance Name&gt;.&lt;Skill Group Name&gt;</code>.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>A description of the record.</td>
<td>Up to 255 characters</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Permit application routing</td>
<td>For non-voice MRDs, checking this box causes the associated multichannel application (rather than IPCC) to perform task routing to agents. Task results will still be returned to IPCC for reporting purposes.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Dialed Number mapping: Calling Line ID (CLID)</td>
<td>For voice MRDs only, optionally, specify whether all Calling Line ID values are valid, or limit values to a predefined region, CLID prefix, or a CLID value. If you want to use a region, select Region and then choose the region name from the drop-down list.</td>
<td>Select region or enter prefix or match as desired.</td>
<td>All</td>
<td>No</td>
</tr>
<tr>
<td>Application String 1</td>
<td>For non-voice MRDs only, optionally, enter an application string that can be used to specify IPCC script execution options. Can contain application specific information that affects the execution of the script. For example, for CCS these might represent call variables that have been mapped to application strings in the CCS inmap and outmap files.</td>
<td>Select All or None, or enter prefix or match as desired.</td>
<td>All</td>
<td>No</td>
</tr>
<tr>
<td>Dialed Number mapping: Caller-entered digits (CED)</td>
<td>For voice MRDs only, optionally, specify whether all Caller-Entered-Digits values are valid for the call type or limit the call type to cases where no CEDs are entered, no CEDs are required, or to a specific CED value.</td>
<td>Select None or enter caller-entered digits as desired.</td>
<td>All</td>
<td>No</td>
</tr>
<tr>
<td>Application String 2</td>
<td>For non-voice MRDs only, optionally, enter an application string that can be used to specify IPCC script execution options. It often contains application specific information that affects the execution of the ICM script. Can contain application specific information that affects the execution of the script.</td>
<td>Select All or None, or enter match as desired.</td>
<td>All</td>
<td>No</td>
</tr>
</tbody>
</table>
## Dialed Number Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialed Number mapping: Call Type</td>
<td>The call type for this mapping</td>
<td>Select from list</td>
<td>First in list</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Index

Admin Workstation....13
Agent....18, 41, 42, 43
    configuring Not Ready reason codes....43
database records....18
teams, creating....41
teams, deleting....42
Agent desk settings....19, 24
    about....17, 19, 26, 28
Idle reason required....24
Logout reason required....24
reason codes....24, 80, 82
Work mode....24
Wrap-up....23, 24, 47
Agent desktop features....23, 79
    configuring using the IPCC Enterprise Web
    Administration Tool....79
Agent Re-skilling tool....28, 49, 83
    about....17, 19, 26, 28
accessing....49, 83
agents....39, 71, 72, 75
    assigning to skill groups....72
    assigning to teams....72, 75
creating....18, 39, 41, 42, 71, 75, 79, 82, 85
desk settings....72, 79
Agents....17, 19, 20, 23, 24, 28, 39, 40, 42, 77
    about....17, 19, 26, 28
administering....17
changing skill group designations....28
creating multichannel....42
creating multichannel using the IPCC Enterprise Web
    Administration Tool....77
creating voice-only....39
deleting multichannel....42
deleting multichannel using the IPCC Enterprise Web
    Administration Tool....77
deleting voice-only....40
entering Wrap-up mode....23
multichannel....17
multichannel, creating....42
multichannel, creating using the IPCC Enterprise Web
    Administration Tool....77
multichannel, deleting....42
multichannel, deleting using the IPCC Enterprise Web
    Administration Tool....77
reason codes....24, 80, 82
supervisors....19, 75
teams....19, 72, 75
teams, multichannel....20
voice-only....17
agent state trace....72
Agent supervisor....41
    creating....18, 39, 41, 42, 71, 75, 79, 82, 85
deleting....40, 41, 42
Agent teams....19, 41, 42
    about....17, 19, 26, 28
creating....18, 39, 41, 42, 71, 75, 79, 82, 85
deleting....40, 41, 42
Agent types....17
    multichannel....17
    voice-only....17
Agent wrap-up....23, 47
    configuring....36, 43, 47, 58
Alphanumeric substitutions, configuring....60
Alpha prefixes, adding to numbers....61
Assist call method, configuring....47
Barge-in option....28
Base skill groups....33, 34
    migrating from subskill groups....34
blind conference calls....80
CAD....25, 48, 83
    configuring supervisor logged-in state....48, 83
    configuring Work Mode on Incoming option....24, 25
    configuring Work Mode on Outgoing option....25
    predefined reason codes....25
Call forward on Redirection on No Answer....26
Call forward on Ring No Answer....44, 45
    configuring IPCC on CVP/ISN....45
    configuring IPCC on IP IVR....44
callrouter....13
call types....31, 86
    mapping to dialed number....86
Call types....31
Call types, identification....61
Cisco Collaboration Server....36
Cisco Media Blender....36
Classifying call types....61
Collaboration Server....36
Configuration Parameters....53
Configuring....24, 25, 31, 36, 41, 43, 47, 48, 50, 51, 53, 60, 83, 84
    agent teams....41, 42
    alphanumeric substitutions....58, 60
    Assist call and Emergency alert methods....47
    automatic wrap-up....47
    CAD supervisor logged-in state....48, 83
device target with IPCC Enterprise....53
multichannel software, about....36
network transfer for IVRs....84
network transfer from a CTI OS Agent Desktop....51
network transfer from an IP phone....50
Not Ready reason codes....43
    routing, about....31, 34
    speed dialing....60
    Static Dial String translations....60
Work Mode on Incoming option for CAD....25
Work Mode on Incoming option for CTI OS Agent Desktop....24
Work Mode on Outgoing option for CAD....25
consultative calls....80
Creating....39, 41, 42, 71, 77
agents....39, 71, 72, 75
agent supervisor....41
agents using the IPCC Enterprise Web Administration Tool....71
agent teams....41, 42
multichannel agents....42
multichannel agents using the IPCC Enterprise Web Administration Tool....77
voice-only agents....39
CTI OS Agent Desktop....24, 51
    configuring network transfer....51
    configuring Work Mode on Incoming option....24, 25
CTI OS Server....13
CTI Server....13
customer instance....14
Database....18
    Agent record....18
    Person record....18
    records for IPCC Enterprise agents using multichannel software....18
databases....14
    automatic installation....14
Deleting....40, 41, 42, 77
agent supervisor....41
agent teams....41, 42
multichannel agents....42
multichannel agents using the IPCC Enterprise Web Administration Tool....77
voice-only agents....18, 39, 40
desk settings....72, 79
    assigning to agents....72
creating....18, 39, 41, 42, 71, 75, 79, 82, 85
Desk settings, agent....23
Desktop features, configuring....23
Device target....54
    routing to a new....54
device targets....14, 32
Device targets....32, 53
    configuring with IPCC Enterprise....53
Dialed Number Plan....57, 58, 59, 60, 61, 85
    alphanumeric substitutions....58, 60
    configuring....36, 43, 47, 58
    dialed number....58
    dial number type plan....61
    dial string....60
    Post Route....58
    Post Route field....59
    routing agent-initiated calls....58
Routing Client field....59
    specifying basic dialing substitutions....58
    speed dialing....60
    using the IPCC Enterprise Web Administration Tool....85
    values....58
    Wildcard pattern....59
dialed numbers....31, 85
    creating....18, 39, 41, 42, 71, 75, 79, 82, 85
Dialed numbers....31
Dialing substitutions, Dialed Number Plan....58
Dial string....60
    using for alphanumeric substitutions....60
Distributor AW....13
Duplicate extensions....53
ECC variables....14
Emergency alert method, configuring....47
Emergency calls....27
expanded call context variables....14
filtering lists....69
global options....74
    for agents....74
HDS....13
Historical Data Server....13
ICM components in IPCC....13
ICM software, comparing components and features with System IPCC....13
instance....14
Intercept option....28
IPCC Enterprise, performing administrative tasks....39
IPCC Enterprise Web Administration Tool, about....67
ipcc instance....14
labels....14, 32
Labels....32
lists....69
    filtering....69
    sorting....69
logger....13
login....67
Media Blender....36
media routing domain....86
    for dialed numbers....86
Migrating from subskill groups to base skill groups....34
Modes, Wrap-up....23
MR PG....13
Multichannel agent database records....18
Multichannel agents....17, 18, 42, 77
    creating....18, 39, 41, 42, 71, 75, 79, 82, 85
    creating using the IPCC Enterprise Web Administration Tool....77
    deleting....40, 41, 42
    deleting using the IPCC Enterprise Web Administration Tool....77
Multichannel routing, about configuring....35
Multichannel routing requests, about....35
Multichannel software....18, 36
Cisco Collaboration Server....36
Cisco E-Mail Manager....36
Cisco Media Blender....36
configuring....36, 43, 47, 58
database records for IPCC Enterprise agents....18
Multi-site installations....53
duplicate extensions....53
Network transfer....29, 50, 51
configuring from a CTI OS Agent Desktop....51
configuring from an IP Phone....50
for IVRs, about....29
network vru....14
not ready reason codes....80, 82
outbound....86
dialed number for....86
Outbound Dialer....13
password....67
passwords....72
agents and supervisors....72
permissions....72
Person database record....18
persons....14
post routing....14
Predefined reason codes....25
Queue requests....30
reason codes....24, 80, 82
creating....18, 39, 41, 42, 71, 75, 79, 82, 85
requiring....80
Reason codes....24, 25, 43
configuring....36, 43, 47, 58
idle reason required....24
logout reason required....24
predefined....25
Wrap-Up....24
Redirection on No Answer....26, 44, 45
about....17, 19, 26, 28
configuring IPCC on CVP/ISN....45
configuring IPCC on IP IVR....44
Re-skilling Tool....67
accessing and logging in....67
ring no answer....80
Route requests....30
Routes....32
Routing....29, 30, 31, 32, 33, 34, 35, 53, 54, 58
about IPCC Enterprise....29
agent calls with the Dialed Number Plan....58
and queuing requests....30
call to the VRU....30
call types....31, 86
client....29
configuration, about....31
configuring for multichannel, about....35
device targets....14, 32
dialed numbers....31, 85
labels....14, 32
multichannel requests, about....35
operations, about....29
scripts, about....34
services....14, 33
skill groups....14, 33, 72
subskill groups....33
to a target device....54
to the VRU with IPCC Enterprise....30
voice calls....53
VRU....30
Scripts....34
routing, about....31, 34
services....14, 33
Services....33
skill groups...14, 33, 72
assigning agents to...72, 75
sub....14, 33
Skill groups...28, 33, 34
base....33
changing agent designation...28
migrating from subskills to base skills....34
sub....14, 33
sorting lists....69
Speed....60
dial, configuring....60
dialing, Dialed Number Plan....60
Speed dialing, configuring....60
Static dial string translations....60
Subskill group masks....33
Subskill groups....33, 34
enabling the subskill group mask....33
migrating to base skill groups....34
sub skill groups....14
Supervisor....20, 27, 41, 47
assist calls....27, 47
creating agent....41
deleting agent....41, 42
required information when creating....20
supervisor assist....80
in agent desk settings....80
Supervisor features....27, 48, 83
configuring, about....27
configuring, how to....48, 83
monitoring agent team members....27
supervisors....19, 75
assigning to teams....72, 75
creating....18, 39, 41, 42, 71, 75, 79, 82, 85
Supervisors....19, 28
assigning primary and secondary....19
using Barge-In option....28
using Intercept option....28
using the Agent Re-skilling Tool....28
System IPCC....13, 67
compared with ICM components and features....13
performing administrative tasks....67
system pg....13, 14
Target devices....54
teams....19, 72, 75
assigning agents to....72, 75
creating....18, 39, 41, 42, 71, 75, 79, 82, 85
Teams....19, 41, 42
agent....19
creating agent....41
deleting agent....41, 42
translation routes....14
trunk groups....14
url....67
username....67
Voice calls, routing....53
Voice-only agents....18, 39, 40
creating....18, 39, 41, 42, 71, 75, 79, 82, 85
deleting....40, 41, 42
VRU routing....30
Web collaboration....36
WebView....13, 14, 75
automatic installation....14
installation location....13
permissions for....75
supervisor access....75
Wildcard characters....61
combining with alphanumeric substitution....61
work mode....80
Work mode, agent wrap-up....24
Wrap-up....23, 24, 47
configuring...36, 43, 47, 58
reason codes...24, 80, 82
reason codes and work mode....24
Wrap-Up reason codes and work mode....24